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Package Contents

Contents of Package:
D-Link AirPlus G DI-524

" 802.11g/2.4GHz Wireless Router
- Power Adapter-DC 5V, 2.5A
Manual and Warranty on CD
" Quick Installation Guide
B Ethernet Cable (All the DI-524’s Ethernet ports are Auto-MDIX)
|

Note: Using a power supply with a different voltage rating than the one included with
the DI-524 will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

System Requirements for Configuration:
B Ethernet-Based Cable or DSL Modem

B Computers with Windows, Macintosh, or Linux-based
operating systems with an installed Ethernet adapter

B Internet Explorer Version 6.0 or Netscape Navigator
Version 6.0 and Above



Introduction

The D-Link AirPlus G DI-524 802.119/2.4 Ghz Wireless Router is an 802.11g high-
performance, wireless router that supports high-speed wireless networking at home,
at work or in public places.

Unlike most routers, the DI-524 provides data transfers at up to 54 Mbps* (compared to
the standard 11 Mbps) when used with other D-Link AirPlus G products. The 802.11g
standard is backwards compatible with 802.11b products. This means that you do not
need to change your entire network to maintain connectivity. You may sacrifice some of
802.11¢g’s speed when you mix 802.11b and 802.11g devices, but you will not lose the
ability to communicate when you incorporate the 802.11g standard into your 802.11b
network. You may choose to slowly change your network by gradually replacing the
802.11b devices with 802.11g devices .

In addition to offering faster data transfer speeds when used with other 802.11g products,
the DI-524 has the newest, strongest, most advanced security features available today.
When used with other 802.11g WPA (WiFi Protected Access) and 802.1x compatible
products in a network with a RADIUS server, the security features include:

WPA: Wi-FiProtected Access authorizes and identifies users based on a secret key
that changes automatically at a regular interval. WPA uses TKIP (Temporal
Key Integrity Protocol) to change the temporal key every 10,000 packets (a
packet is a kind of message transmitted over a network.) This insures much
greater security than the standard WEP security. (By contrast, the older WEP
encryption required the keys to be changed manually.)

802.1x: Authentication is a first line of defense against intrusion. In the Authentication
process the server verifies the identity of the client attempting to connect to the
network. Unfamiliar clients would be denied access.

For home users that will not incorporate a RADIUS server in their network, the security
for the DI-524, used in conjunction with other 802.11g products, will still be much stronger
than ever before. Utilizing the Pre Shared Key mode of WPA, the DI-524 will obtain a
new security key every time it connects to the 802.11g network. You only need to input
your encryption information once in the configuration menu. No longer will you have to
manually input a new WEP key frequently to ensure security, with the DI-524, you will
automatically receive a new key every time you connect, vastly increasing the safety
of your communications.

*Maximum wireless signal rate based on IEEE Standard 802.11g specifications. Actual data throughput will
vary. Network conditions and environmental factors, including volume of network traffic, building materials
and construction, and network overhead lower actual data throughput rate.
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Connections

All Ethernet Ports (WAN and LAN)
are auto MDI/MDIX, meaning you
can use either a straight-through or
a crossover Ethernet cable.

Pressing the
Reset Button
restores the
router to its
original factory
default settings.

Auto MDI/MDIX
LAN ports
automatically sense
the cable type
when connecting to
Ethernet-enabled
computers.

The Auto MDI/
MDIX WAN port is
the connection for
the Ethernet cable
to the Cable or
DSL modem.

Receptor
for the
Power
Adapter.




LEDs

WAN LED

A solid light indi-
cates connection
on the WAN port.
This LED blinks du
ing data transmis-
sion.

v

WLAN LED

A solid light
indicates that the
wireless segment
is ready. This LED
blinks during wire-
less data trans-
mission.

wireless I
Router

\

STATUS
POWER LED A blinking light
A solid light in- indicates that the
dicates a proper DI-524 is ready.
connection to the

power supply.

LOCAL
NETWORK LED

A solid light indi-
cates a connection
to an Ethernet-en-
abled computer on
ports 1-4. This LED
blinks during data
transmission.




Features

B Fully compatible with the 802.11g standard to provide a wireless data rate of
up to 54Mbps.*

B Backwards compatible with the 802.11b standard to provide a wireless data
rate of up to 11Mbps.

B WPA (Wi Fi Protected Access) authorizes and identifies users based on a
secret key that changes automatically at a regular interval, for example:

B TKIP (Temporal Key Integrity Protocol), in conjunction with a RADIUS
server, changes the temporal key every 10,000 packets, ensuring
greater security.

M Pre Shared Key mode means that the home user, without a RADIUS
server, can connect securely via a pre-shared key, vastly improving the
safety of communications on the network.

B 802.1x Authentication in conjunction with the RADIUS server verifies the
identity of would be clients.

B Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing).

B User-friendly configuration and diagnostic utilities.

B Operates in the 2.4GHz frequency range.

B Connects multiple computers to a Broadband (Cable or DSL) modem to
share the Internet connection.

B Advanced Firewall features

W Supports NAT with VPN pass-through, providing added security
W MAC Filtering

M |P Filtering

B URL Filtering

W Domain Blocking

M Scheduling

W DHCP server enables all networked computers to automatically receive IP
addresses.

B Web-based interface for Managing and Configuring.

B Access Control to manage users on the network.

B Supports special applications that require multiple connections.

B Equipped with 4 10/100 Ethernet ports, 1 WAN port, Auto MDI/MDIX.

*Maximum wireless signal rate based on IEEE Standard 802.11g specifications. Actual data throughput will
vary. Network conditions and environmental factors, including volume of network traffic, building materials
and construction, and network overhead lower actual data throughput rate. 7



Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and
compatible high-speed wireless connectivity within your home, business or public
access wireless networks. D-Link wireless products will allow you access to the data
you want, when and where you want it. You will be able to enjoy the freedom that
wireless networking brings.

AWLAN is a cellular computer network that transmits and receives data with radio signals
instead of wires. WLANSs are used increasingly in both home and office environments,
and public areas such as airports, coffee shops and universities. Innovative ways to
utilize WLAN technology are helping people to work and communicate more efficiently.
Increased mobility and the absence of cabling and other fixed infrastructure have proven
to be beneficial for many users.

Wireless users can use the same applications they use on a wired network. Wireless
adapter cards used on laptop and desktop systems support the same protocols as
Ethernet adapter cards.

People use wireless LAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-time
information can significantly improve worker efficiency.

Low Implementation Costs — WLANs are easy to set up, manage, change
and relocate. Networks that frequently change can benefit from WLANs ease of
implementation. WLANs can operate in locations where installation of wiring may be
impractical.

Installation and Network Expansion - Installing a WLAN system can be fast and
easy and can eliminate the need to pull cable through walls and ceilings. Wireless
technology allows the network to go where wires cannot go - even outside the home
or office.

Scalability — WLANSs can be configured in a variety of topologies to meet the needs
of specific applications and installations. Configurations are easily changed and range
from peer-to-peer networks suitable for a small number of users to larger infrastructure
networks to accommodate hundreds or thousands of users, depending on the number

of wireless devices deployed.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices.



Wireless Basics (continued)

Standards-Based Technology
The DI-524 Wireless Broadband Router utilizes the new 802.11g standard.

The IEEE 802.11g standard is an extension of the 802.11b standard. It increases the
data rate up to 54 Mbps* within the 2.4GHz band, utilizing OFDM technology.

This means that in most environments, within the specified range of this device, you
will be able to transfer large files quickly or even watch a movie in MPEG format over
your network without noticeable delays. This technology works by transmitting high-
speed digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division
Multiplexing) technology. OFDM works by splitting the radio signal into multiple
smaller sub-signals that are then transmitted simultaneously at different frequencies
to the receiver. OFDM reduces the amount of crosstalk (interference) in signal
transmissions.

The DI-524 is backwards compatible with 802.11b devices. This means that if you have
an existing 802.11b network, the devices in that network will be compatible with 802.11g
devices at speeds of up to 11Mbps in the 2.4GHz range.

*Maximum wireless signal rate based on IEEE Standard 802.11g specifications. Actual data throughput will
vary. Network conditions and environmental factors, including volume of network traffic, building materials
and construction, and network overhead lower actual data throughput rate.

9



Wireless Basics (continued)

Installation Considerations

The D-Link AirPlus G DI-524 lets you access your network, using a wireless connection,
from virtually anywhere within its operating range. Keep in mind, however, that the
number, thickness and location of walls, ceilings, or other objects that the wireless signals
must pass through, may limit the range. Typical ranges vary depending on the types of
materials and background RF (radio frequency) noise in your home or business. The
key to maximizing wireless range is to follow these basic guidelines:

Keep the number of walls and ceilings between the DI-524 and other network
devices to a minimum - each wall or ceiling can reduce your D-Link wireless
product’s range from 3-90 feet (1-30 meters). Position your devices so that
the number of walls or ceilings is minimized.

Be aware of the direct line between network devices. A wall that is 1.5 feet
thick (.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter)
thick. At a 2-degree angle it looks over 42 feet (14 meters) thick! Position
devices so that the signal will travel straight through a wall or ceiling (instead
of at an angle) for better reception.

Building Materials can impede the wireless signal - a solid metal door or
aluminum studs may have a negative effect on range. Try to position wireless
devices and computers with wireless adapters so that the signal passes
through drywall or open doorways and not other materials.

Keep your product away (at least 3-6 feet or 1-2 meters) from electrical
devices or appliances that generate extreme RF noise.

10



Getting Started

J Cable/DSL Modem

=DI-524

802. 116;2 4GHz
lw.mss outer

. 7 .
@ Computer 1 '
Jesktol La _....-l— -
‘ Computer 2 @

®

Computer 3 @

You will need broadband Internet access (a Cable or DSL-subscriber line into
your home or office).

e Consult with your Cable or DSL provider for proper installation of the modem.

Connect the Cable or DSL modem to the DI-524 Wireless Broadband Router
(see the printed Quick Installation Guide included with your router).

If you are connecting a desktop computer to your network, install the D-Link
AirPlus G DWL-G510 wireless PCI adapter into an available PCI slot on your
desktop computer. You may also install the DWL-G520, or the DWL-520.
(See the printed Quick Installation Guide included with the network adapter.)

@ Install the D-Link DWL-G630 wireless Cardbus adapter into a laptop computer.
(See the printed Quick Installation Guide included with the DWL-G630.)

Install the D-Link DFE-530TX+ adapter into a desktop computer. The four
Ethernet LAN ports of the DI-524 are Auto MDI/MDIX and will work with both
Straight-Through and Cross-Over cable.

(See the printed Quick Installation Guide included with the DFE-530TX+.)11



Using the Configuration Menu

Whenever you want to configure your network or
the DI-524, you can access the Configuration Menu

‘A Microsoft Internet Explorer

by opening the web-browser and typing in the IP F B Ak To e

Address of the DI-524. The DI-524 default IP Address
is shown at right:

cﬂm}- - lﬂ Q ; /-’Emu. ,

address ] hetpeff192. 1680507

B Open the web browser
B Type in the IP Address of 2] ]

the Router (http://192.168.0.1) " _

Note: if you have changed the default IP Address assigned to
the DI-524, make sure to enter the correct IP Address. D524
ser nae: [€ =anin =
[ ] Type admin in the User Bassnorc: [
Name field I Ty R
[ ] Leave the Password
blank [ ] e |
| Click OK

Home > Wizard

AirPlusG

B802.11g9/2.4GHz Wireless Router
The Home>Wizard

. R B UM Advanced _Tools ___Status ___Help__|
screen will appear. - i WA
Please refer to the e St e s ok e o S
Quick Installation ,E“..‘m.:..:...“:.;w s Bl mp o o e
Guide for more infor- e
mation regarding the
Setup Wizard. T o
Help
-
These buttons appear a Clicking Apply will save changes made to the page-
on most of the configu- Apply
ration screens in this
section. Please click on Q Clicking Cancel will clear changes made to the page.
the appropriate button Cancel
at the bottom of each
screen after you have o Clicking Help will bring up helpful information regarding the page.
made a configuration Help
change.

@ Clicking Restart will restart the router. (Necessary for some changes.)

Restart
12



Using the Configuration Menu (continued)

SSID-

Channel-

WEP-

WEP Encryption-
Key Type-

Keys 1-4-

Home > Wireless

D-Link

Building Networks for Peogple

AirPlusG

802.11g/2.4GHz Wireless Router
Home Advanced  Tools Status ___Help

These are the wircless settings for the AP{Access Point)Portion.

SSI0 idelault
Channel ; ’E
WEP:  Enabled * Disabled
WER Encryption : |64Bit "I
Key Type © [HEX —I
Kuy! . & [0000000000
Key2 . ¢ [D000000000
Key3: ¢ [DODOOO0O00
Drch Keyd: € [00DUDDO000

DHF‘.

) =
FWizard
| Wircless
—
|
"o |

2 90

Apply Cancel Help

Service Set Identifier (SSID) is the name designated for a spe-
cific wireless local area network (WLAN). The SSID’s factory
default setting is default. The SSID can be easily changed to
connect to an existing wireless network or to establish a new
wireless network.

6 is the default channel. All devices on the network must share
the same channel. (Note: The wireless adapters will automati-
cally scan and match the wireless setting.)

Wired Equivalent Privacy (WEP) is a wireless security protocol
for Wireless Local Area Networks (WLAN). WEP provides se-
curity by encrypting the data that is sent over the WLAN. Select
Enabled or Disabled. Disabled is the default setting. (Note: If
you enable encryption on the DI-524 make sure to also enable
encryption on all the wireless clients or wireless connection will
not be established.)

Select the level of encryption desired: 64-bit, or 128-bit.
Select HEX or ASCII.

Input up to 4 WEP keys; select the one you wish to use.
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Using the Configuration Menu (continued)

Dynamic
IP Address-

Host Name-

MAC Address-

Clone
MAC Address-

Home > WAN > Dynamic IP Address

AirPlusG

802.11g/2.4GHz Wireless Router

DHF‘
] (T - Advanced  Tools Status __ Help
[ Bloase select The appropriale oplon 1o conmec! to your IS8
Wizard
& Dynamic [P Addmss Choosa this option to obtain an IP address automatically
from your ISP, (For mozt Cable modem users)
T Wireless © Static 1P Address Choose i option o set stalc B information provded 1o
you by your 1SE
" PPPoE Choose this option if your ISP uses PPPE. (For most
D35L usars)
WAN  Others PRTR and BigPond Cabile
© ppTR (for Europe use only)
LY i
Hast Name =] {optional)
—
DHCP MAC Address o .ke .FF .F .0 .
E {optional) Clone MAG Addruss
2 00
Apply Cancel Help

Choose Dynamic IP Address to obtain IP Address information
automatically from your ISP. Select this option if your ISP does
not give you any IP numbers to use. This option is commonly
used for Cable modem services.

The Host Name is optional but may be required by some ISPs.
The default host name is the device name of the Router and
may be changed.

The default MAC Address is set to the WAN’s physical interface
MAC address on the Broadband Router. It is not recommended
that you change the default MAC address unless required by
your ISP.

The default MAC address is set to the WAN’s physical interface
MAC address on the Broadband Router. You can use the “Clone
MAC Address” button to copy the MAC address of the Ethernet
Card installed by your ISP and replace the WAN MAC address
with the MAC address of the router. It is not recommended
that you change the default MAC address unless required by
your ISP.

14



Using the Configuration Menu (continued)

Home > WAN > Static IP Address

AirPlus(G
802.11a/2.4GHz Wireless Router

DI-524
i LU Advanced  Tools  Status ___Help

Please select the appropriate oplion 1o connec lo your ISP,
) Dynamic IP Address Choose this oplion Lo oblain an P address aulomatically
from your ISP, (For most Cable modem users)

& Statie IP Addrass Cheose this option to set stabic IP information prewded to

DSL users)
) Others PPTP and BigPond Cahle

) PPTP {far Eurape use anly)

Wireless you by your ISP,
) PPPoE Choose this option f your ISP uses PPPoE. (For most
J LAN

IP Address 0000 (assigned by your ISP)
Subnet Mask nonn
e ISP Gateway Address 0000
Primary DNS Address nonn
Secondary DNS Address 0000 {optional)

9 9O

Apply Cancel Help

Static IP Address- Choose Static IP Address if all WAN IP information is provided
to you by your ISP. You will need to enter in the IP address,
subnet mask, gateway address, and DNS address(es) provided
to you by your ISP. Each IP address entered in the fields must
be in the appropriate IP form, which are four octets separated
by a dot (x.x.x.x). The Router will not accept the IP address if
it is not in this format.

IP Address- Input the public IP Address provided by your ISP.

Subnet Mask- Input your Subnet mask. (All devices in the network must have
the same subnet mask.)

ISP

Gateway Address- Input the public IP address of the ISP to which you are
connecting.

Primary

DNS Address- Input the primary DNS (Domain Name Server) IP address
provided by your ISP.

Secondary

DNS Address- This is optional.

15



Using the Configuration Menu (continued)

Please be sure to
remove any exist-

ing PPPoE cli-
& ent software

installed on
your  com-
puters.

Choose PPPoE (Point
to Point Protocol over
Ethernet) if your ISP
uses a PPPoE con-
nection. Your ISP will
provide you with a
username and pass-
word. This option is
typically used for DSL
services. Select Dy-
namic PPPoE to ob-
tain an IP address
automatically for your
PPPoE connection.
Select Static PPPoE
to use a static IP ad-
dress for your PPPoE
connection.

PPPOE-

User Name-

Retype Password-

Service Name-
IP Address-

Primary DNS
Address-

Secondary DNS
Address-

Home > WAN > PPPoE

AirPlus(G

802.11g9/2.4GHz Wireless Router
[ __Home JVEVUCYIN Tools

Flease select the appropnate ophion to connect to your ISP,

Status Help

O Dynamic IP Address Choose this oplion to obtain an 1P address automatically
from your ISP. (For most Cable modem users)

Choose thie option Lo el static IP information provided to
you by your ISP,

Choose this option if your ISP uses PPPE. (For most
DSL users)

PPTP and BigPond Cable

J— O Static IP Address
Wireless s

@ PPPoE

) Others

O PPTP {for Europe use only)
e
= Dynamic PPPoE 0 Static PPPoE
W Usar Nama
Pasaward SEANAENNRRRARARGRRRRRRRES

Retype Password SEEEENNENEENNNNEEENNNERES

Senvice Name {optional)
IP Address

Primary ONS Address
Secondary ONS Address {optional)
Maimum ldle Time o Minutes
ML 1492

Auta-reconnect (%) Enabled (O Disabled

2 90

Apply Cancel Help

Choose this option if your ISP uses PPPoE. (Most DSL users
will select this option.)
Dynamic PPPoE- receive an IP Address automatically from your ISP.

Static PPPoE-you have an assigned (static) IP Address.
Your PPPoE username provided by your ISP.

Re-enter the PPPoE password

Enter the Service Name provided by your ISP (optional).

This option is only available for Static PPPoE. Enter the static
IP Address for the PPPoE connection.

Primary DNS IP address provided by our ISP

This option is only available for Static PPPoE. Enter the static
IP Address for the PPPoE connection.

(Continued on the next page)
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Using the Configuration Menu (continued)

Home > WAN > PPPoE continued

Maximum Enter a maximum idle time during which Internet connection
Idle Time- is maintained during inactivity. To disable this feature, enable
Auto-reconnect.

MTU- Maximum Transmission Unit-1492 is the default setting-you
may need to change the MTU for optimal performance with
your specific ISP.

Auto-reconnect- If enabled, the DI-524 will automatically connect to your ISP after
your system is restarted or if the PPPoOE connection is dropped.

Home > LAN

D-Link

Building Hetworks for Pecple

AirPlusG

802.11g9/2.4GHz Wireless Router

DI-5 ¥
]3‘ ! 1 -3 Advanced  Tools Status Help
The IP address of the D624,

P Address 192,168.0.1

Subnel Mask EJ&JJ‘J&U

ILE

Ry Local Domain Name | {ophional)
AN Apply Cancel Help

i

DHCP

LAN is short for Local Area Network. This is considered your internal network. These are
the IP settings of the LAN interface for the DI-524. These settings may be referred to as
Private settings. You may change the LAN IP address if needed. The LAN IP address
is private to your internal network and cannot be seen on the Internet.

IP Address- The IP address of the LAN interface. The default IP address
is: 192.168.0.1.

Subnet Mask- The subnet mask of the LAN interface.
The default subnet mask is 255.255.255.0.

Local Domain- This field is optional. Enter in the local domain name.

17



Using the Configuration Menu (continued)

Home > DHCP

D-Link

Building Networks for Feople

AirPlusG

802.119/2. 4GHz Wireless Router

DI-524
T 1\ -9 Advanced  Tools Status Help
The DLE24 can be setup as a DHCP Server to distribute IP addresses to the LAN
W netwark,
DHCP Server & Enabled © Disabled
EE— Starting IP Addross 192 . 168 .0. I“Il
Wireless
Ending IP Address 192160 0. [199
T Luase Time 1 Week =
— 2 90O
e Apply Cancel Help
Host Mama P Addrass MAL Addrass Expirad Tima

DHCP uknewn 1921680101 00-50-BA-TD-E5-E1 Janf 032003 17.0805

DHCP stands for Dynamic Host Control Protocol. The DI-524 has a built-in DHCP
server. The DHCP Server will automatically assign an IP address to the computers on
the LAN/private network. Be sure to set your computers to be DHCP clients by setting
their TCP/IP settings to “Obtain an IP Address Automatically.” When you turn your
computers on, they will automatically load the proper TCP/IP settings provided by the
DI-524. The DHCP Server will automatically allocate an unused IP address from the
IP address pool to the requesting computer. You must specify the starting and ending

address of the IP address pool.

DHCP Server- Select Enabled or Disabled. The default setting is Enabled.
Starting
IP Address- The starting IP address for the DHCP server’s IP assignment.
Ending
IP Address- The ending IP address for the DHCP server’s IP assignment.
Lease Time- The length of time for the IP address lease. Enter the Lease

time. The default setting is one hour.
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Using the Configuration Menu (continued)

Advanced > Virtual Server

-
D-Link ; -
Building Metwarks for Peaple Alr p I us G
802.11g9/2.4GHz Wireless Router
DI-524
E L _Home VLTI Tools — Status — Help |
Wirtual Server 15 used to allow Intemet users access to LAN semices.
" Enabled © Disablad
q Mame I Clear I
Rl I—
Pratocol Type ITF‘.J'| 'I
—

T Fiters Private Port |

Public Port |
f Schedule © Atways

Firewall
T From time 00 Vi- o vi A ~||a|m VI -I[I] vi Al 'l

T daril:iun "Im Sun 'I
’f""'_- ./ -
Performance \‘ a o
— : List Apply Cancel Help
MName Private IP Protocol Schedule
T Virtual Server FTP 0000 TCP 211 always IF} ]
I Virtual Server HTTP 0000 TCP 80/80 always g}
T Virtual Server HTTPS 0000 TCP 443/443 always Ef |
I Virtual Server DNS 0000 UDP 53/53 always @

The DI-524 can be configured as a virtual server so that remote users accessing
Web or FTP services via the public IP address can be automatically redirected to
local servers in the LAN (Local Area Network).

The DI-524 firewall feature filters out unrecognized packets to protect your LAN
network so all computers networked with the DI-524 are invisible to the outside world.
If you wish, you can make some of the LAN computers accessible from the Internet
by enabling Virtual Server. Depending on the requested service, the DI-524 redirects

the external service request to the appropriate server within the LAN network.

The DI-524 is also capable of port-redirection meaning incoming traffic to a particular
port may be redirected to a different port on the server computer.

Each virtual service that is created will be listed at the bottom of the screen in the
Virtual Servers List. There are pre-defined virtual services already in the table. You
may use them by enabling them and assigning the server IP to use that particular
virtual service.

19



Using the Configuration Menu (continued)

Advanced > Virtual Server continued

Virtual Server- Select Enabled or Disabled.

Name- Enter the name referencing the virtual service.

Private IP- The server computer in the LAN (Local Area Network) that will
be providing the virtual services.

Protocol Type- The protocol used for the virtual service.

Private Port- The port number of the service used by the Private IP computer.

Public Port- The port number on the WAN (Wide Area Network) side that

will be used to access the virtual service.

Schedule- The schedule of time when the virtual service will be enabled.
The schedule may be set to Always, which will allow the
particular service to always be enabled. If it is set to Time,
select the time frame for the service to be enabled. If the
system time is outside of the scheduled time, the service will

be disabled.

Example #1: If you have a Web server that you wanted Internet users
to access at all times, you would need to enable it. Web
(HTTP) server is on LAN (Local Area Network) computer
192.168.0.25. HTTP uses port 80, TCP.
Name: Web Server
Private IP: 192.168.0.25
Protocol Type: TCP
Private Port: 80
Public Port: 80

Schedule: always

20



Using the Configuration Menu (continued)

Advanced > Virtual Server continued

withial Sepewrs Lisd
Hair=s Himvafe IH Hrofocod T -1 [ [
Eovarh ol S HL P TH? THA [ M L e B | e 12

' ? Click on this icon to edit the virtual service

" tl Click on this icon to delete the virtual service

Example #2:

If you have an FTP server that you wanted Internet users to access by WAN port
2100 and only during the weekends, you would need to enable it as such. FTP
server is on LAN computer 192.168.0.30. FTP uses port 21, TCP.

Name: FTP Server
Private IP: 192.168.0.30
Protocol Type: TCP
Private Port: 21

Public Port: 2100

Schedule: From: 01:00AM to 01:00AM, Sat to Sun

All Internet users who want to access this FTP Server
must connect to it from port 2100. This is an example of
port redirection and can be useful in cases where there
are many of the same servers on the LAN network.

21



Using the Configuration Menu (continued)
Advanced > Applications

D-Link

Building Networks for Foaple

Some applications require multiple connections, such as Internet gaming, video
conferencing, Internet telephony and others. These applications have difficulties working
through NAT (Network Address Translation). Special Applications makes some of these
applications work with the DI-524. If you need to run applications that require multiple
connections, specify the port normally associated with an application in the “Trigger Port”
field, select the protocol type as TCP or UDP, then enter the public ports associated

AirPlus(G

802.11g9/2.4GHz Wireless Router

ST Advonced  IETYTERCTTTTT

ion i used to run applications that require multiple connections.

Spacial ‘,_.,_"

€ Enabled © Disabled

Mame

|
Trigyer Porl _I
Ingger lype ICP =

Public Port |

Hublic Type ICP =

9 90

pecial Applicatic st Apply Cancel Help
MAME Trigyer Public

I~ Eanle.net 6112 6112

I~ Dalpad T175 51200-51201.51210

FIcun 2019 2000-2038,2050-2051,2069,2085,3010-3030

™ MESN Ganung Zone 47624 2500-2400 2HR00-29000

™ PC-lo-Fhone 12053 12120,12122,24150-24220

™ Quack Time 4 554 6970-6599

SRR

with the trigger port to open them for inbound traffic.

The DI-524 provides some predefined applications in the table on the bottom of the

web page. Select the application you want to use and enable it.
Note! Only one PC can use each Special Application tunnel.

Name-

Trigger Port-

Trigger Type-
Public Port-

Public Type-

This is the name referencing the special application.

This is the port used to trigger the application. It can be either

a single port or a range of ports.

This is the protocol used to trigger the special application.

This is the port number on the WAN side that will be used to
access the application. You may define a single port or a range
of ports. You can use a comma to add multiple ports or port

ranges.

This is the protocol used for the special application.
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Using the Configuration Menu (continued)

Advanced > Filters > IP Filters

D-Link

Building Networks for People

AirPlusG

802.119/2.4GHz Wireless Router

BT Advanced BERTIE " Status Help

Filters are used to allow or deny LAN users from accessing the Internet.

& |P Filters " URL Blocking
 MAC Filters ' Domain Blocking

Use IP Filters to deny LAN IP addresses access to the Internet.

¢ Enabled € Disabled Clear

P 4l

Port I . |
Protocol Type ITCF' 'I

Schedule € Abways

{;m time [00 | - |00 =] JaM =] 1o |00 =] . |00 =] [Am ~]

Fr

day|8un vltngun 'l
----- r List Apply Cancel Help
IP Range Protocol Schedule
B = TCP 20-21 always i
| * TCP 80 always i)

Filters are used to deny or allow LAN (Local Area Network) computers from accessing
the Internet. The DI-524 can be setup to deny internal computers by their IP or MAC
addresses. The DI-524 can also block users from accessing restricted web sites.

IP Filters-

IP-

Port-

Protocol Type-
Schedule-

Use IP Filters to deny LAN IP addresses from accessing the
Internet. You can deny specific port numbers or all ports for
the specific IP address.

The IP address of the LAN computer that will be denied
access to the Internet.

The single port or port range that will be denied access to the
Internet.

Select the protocol type.

This is the schedule of time when the IP Filter will be enabled.
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Using the Configuration Menu (continued)

Advanced > Filters > URL Blocking

D-Link AirPlus(G

802.119/2.4GH= Wireless Router

DI-524
Lo BT  Advanced  [IPTTE Status Help
Filters are used to allow or deny LAM users from accessing the Internet.
'?
Virtual Server

O IP Filters @ URL Blocking
O MAC Filters O Damain Blacking

1 Applications

Blo.ck.th.os.e“U;RLs which contain keywords listed below.

Filters ® Enabled O Disabled

a |amaa !

Firewall

r—

9 9O
— Apply Cancel Help

Performance

URL Blocking is used to deny LAN computers from accessing specific web sites by the
URL. A URL is a specially formatted text string that defines a location on the Internet.
If any part of the URL contains the blocked word, the site will not be accessible and
the web page will not display. To use this feature, enter the text string to be blocked
and click Apply. The text to be blocked will appear in the list. To delete the text, just

highlight it and click Delete.

Filters- Select the filter you wish to use; in this case, URL Blocking
was chosen.

URL Blocking- Select Enabled or Disabled.

Keywords- Block URLs which contain keywords listed below.

Enter the keywords in this space.
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Using the Configuration Menu (continued)
Advanced > Filters > MAC Filters

D-Link

- m
Building Networks for People Alr p Iu 5 G

802.119/2.4GHz Wireless Router

[ Home BT B Tools Status____ Help 1

Di-524

Filters are used to allow or deny LAN users from accessing the Internet.

ViIFtat Server O IP Filters © URL Blacking
© MAC Filters O Domain Blocking

[t

P =
1 Applications

Use MAC address to allow or deny computers access to the netwark,

Filters © Disabled MAC Filters
- @ Only allow computers with MAC address listed below to access the network
rrw;._...—_—— ) Only deny computers with MAC address listed below to access the netwark
R Name [MAC filter 1 [ Clear]
g T MAC Address (00 |_[s0 | [c0 | [a1 |23 |.[e9 |

DHCP Client | v|
Performance a a O

Apply Cancel Help

[

Name MAC Addrass

Use MAC (Media Access Control) Filters to allow or deny LAN (Local Area Network)
computers by their MAC addresses from accessing the Network. You can either manually
add a MAC address or select the MAC address from the list of clients that are currently

connected to the Broadband Router.

Filters- Select the filter you wish to use; in this case, MAC filters was
chosen.

MAC Filters- Choose Disable MAC filters; allow MAC addresses listed
below; or deny MAC addresses listed below.

Name- Enter the name here.

MAC Address- Enter the MAC Address.

DHCP Client- Select a DHCP client from the pull-down list; click Clone to
copy that MAC Address.
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Using the Configuration Menu (continued)
Advanced > Filters > Domain Blocking

D-Link

- e
Building Networks for People Alr p I u s G

802.119/2.4GHz Wireless Router

| Home BV LB Tools Status Help

D
Filters are used to allow or deny LAM users from accessing the Internet.

|-5jz4
?
O &Ly O LRk BIOCking
Filters

) MAC Filters (& Domain Blocking

Appiications Domain Blocking

O Disabled
& Allow users to access all domains except "Blocked Domains”
) Deny users to access all domains except "Permitted Domains”

!; Permitted Domains
EeWOn [wnniy cllink. com)] __|
—
—— — .
Performance Blocked Domains
]
~
|
I

Domain Blocking is used to allow or deny LAN (Local Area Network) computers from
accessing specific domains on the Internet. Domain blocking will deny all requests to
a specific domain such as http and ftp. It can also allow computers to access specific

sites and deny all other sites.

Filters- Select the filter you wish to use; in this case, Domain Blocking
Domain Blocking- was chosen.

Disabled- Select Disabled to disable Domain Blocking.

Allow-

Allows users to access all domains except Blocked Domains.

Deny- Denies users access to all domains except
Permitted Domains.

Permitted
Domains- Enter the Permitted Domains in this field.

Blocked Domains- Enter the Blocked Domains in this field.
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Using the Configuration Menu (continued)

Advanced > Firewall

. &)
AirPlus G
802.11g/2.4GHz Wireless Router
f lm\rall iiufés can be used to allow or deny traffic from passing through the DHG24,
'Virtual Server

" Ensbled ¢ Disabled

Name Clear

peten Wog) il
Interface P Range Stat 1P Rangs End Protocoel Port Range

Source |' ;” |
s Destination |~ =|| | [TeP ﬂl !
Schedule  © Always
Firewall € From time [00 7] - [0 =] [AM =] 10 [0 =] - [0 =] [AM =]
day [Sun = tDIRun 'I
Somz 9 0O
eveal Li Apply Cancel Help
T—:—-_—.u Action Name Source  Destination Frotocol
Performance W Allow  Allow to Ping WAN part WAN® LAN192 18801  1cMPE 4
P Deny Default iy LaN” P @
7 Allow  Dofauh LANZ ** [FN

Firewall Rules is an advanced feature used to deny or allow traffic from passing
through the DI-524. It works in the same way as IP Filters with additional settings.
You can create more detailed access rules for the DI-524. When virtual services are
created and enabled, it will also display in Firewall Rules. Firewall Rules contain all
network firewall rules pertaining to IP (Internet Protocol).

In the Firewall Rules List at the bottom of the screen, the priorities of the rules are
from top (highest priority) to bottom (lowest priority.)

Note:
The DI-524 MAC Address filtering rules have precedence over the Firewall Rules.

Firewall Rules- Enable or disable the Firewall.

Name- Enter the name.

Action- Allow or Deny.

Source- Enter the IP Address range.
Destination- Enter the IP Address range, the Protocol,

and the Port Range.

Schedule- Select Always or enter the Time Range.
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Using the Configuration Menu (continued)

Advanced > DMZ

D-Link

Building Networks for People

AirPlus G

802.119/2.4GHz Wireless Router

DI-524 '
i BT Advanced EPTE Status Help___|

DMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to

T the Intemet.

Yirtual Server

' Enabled & Disahled

IP Address 192168 .0. |D

Applications

Hiters 2 90

Apply Cancel Help

i

I F;_ ull_-

rew

If you have a client PC that cannot run Internet applications properly from behind
the DI-524, then you can set the client up for unrestricted Internet access. It allows a
computer to be exposed to the Internet. This feature is useful for gaming purposes.
Enter the IP address of the internal computer that will be the DMZ host. Adding a
client to the DMZ (Demilitarized Zone) may expose your local network to a variety of

security risks, so only use this option as a last resort.

DMZ- Enable or Disable the DMZ. The DMZ (Demilitarized Zone)
allows a single computer to be exposed to the internet. By
default the DMZ is disabled.

IP Address- Enter the IP Address of the computer to be in the DMZ.

28




Using the Configuration Menu (continued)

Advanced > Performance

D-Link

Building Metwarks for Feaple Air p 'us G
802.11g/2.4GHz Wireless Router
DHF‘
_ [__Home JWETTVIN Tools Status ___Help |
WI re I ess - = [h‘ese‘an‘;‘lhe:\'l;’l.r.el‘;s.s Performance features for the AP{Access Pomnt) Porhion.
Performance- R S Beacon intercal [I00 (msee, range:1~1000, defautt:100)
Displayed in thIS TW RT3 lhmshoﬂd:ﬁﬂ'ﬂ- (range: 286~2432, default:2432)
. . Fragmentation ; E-WJ (range: 256~2346, default-2348, even number only)
window are the Wire- DIMintersal: [3 (range: 1~265, default:3)
less Performance Filters Preamble Type: © Short Preamble @ Long Praamble
features for the Ac- 9 00
cess Point portion of Apply Cancel Help
he DI-524.
the b5 o
Performance
Beacon Interval-  Beacons are packets sent by an Access Point to synchronize

a wireless network. Specify a value. 100 is the default setting
and is recommended.

RTS Threshold- This value should remain at its default setting of 2432. If incon-
sistent data flow is a problem, only a minor modification should
be made.

Fragmentation- The fragmentation threshold, which is specified in bytes, deter-
mines whether packets will be fragmented. Packets exceeding
the 2346 byte setting will be fragmented before transmission.
2346 is the default setting.

DTIM interval- (Delivery Traffic Indication Message) 3 is the default setting. A
DTIM is a countdown informing clients of the next window for
listening to broadcast and multicast messages.

Preamble Type- Select Short or Long Preamble. The Preamble defines the
length of the CRC block (Cyclic Redundancy Check is a com-
mon technique for detecting data transmission errors) for com-
munication between the wireless router and the roaming wire-
less network adapters. Auto is the default setting. Note: High
network traffic areas should use the shorter preamble type.
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Using the Configuration Menu (continued)

Tools> Admin

D-Link

Building Networks for Peaple

AirPlus(G

802.119/2.4GHz Wireless Router

S (LR Status___Help |
I Admin

can change their login password,

| Administrator (The Login Name is “admin®)

_ Mew Password IW

Time
Confim Pagsword I‘W
—_— User (The Lagin name is "user”)
System New Password e
_ Confirm Password I"‘""“'“"'—
Firmware
p—— © Enabled & Dizabled
Mises IP Address F
Port Im 'I

2 90

Apply Cancel Help

At this page, the DI-524 administrator can change the system password. There are two
accounts that can access the Broadband Router’s Web-Management interface. They
are admin and user. Admin has read/write access while user has read-only access.
User can only view the settings but cannot make any changes.

Administrator- admin is the Administrator login name.
Password- Enter the password and enter again to confirm.
User- user is the User login name.

Password- Enter the password and enter again to confirm.

Remote Management- Remote management allows the DI-524 to be configured
from the Internet by a web browser. A username and password is still required to ac-
cess the Web-Management interface. In general, only a member of your network can
browse the built-in web pages to perform Administrator tasks. This feature enables
you to perform Administrator tasks from the remote (Internet) host.

IP Address- The Internet IP address of the computer that has access to the Broad-
band Router. If you input an asterisk (*) into this field, then any computer will be able
to access the Router. Putting an asterisk (*) into this field would present a security risk
and is not recommended.

Port- The port number used to access the Broadband Router.
Example- http://x.x.x.x:8080 where x.x.x.x is the WAN IP address of the Broadband
Router and 8080 is the port used for the Web-Mangement interface.
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Using the Configuration Menu (continued)

Time Zone-

Default
NTP Server-

Set the Time-

Daylight
Saving-

Tools > Time

D-Link

Building Networks for People

AirPlus(G

802.119/2.4GHz Wireless Router

s 3 L O, Status___Help |
- T

Set the DI624 system time.
Admin

Local Time Dec/27/2002 17:31:51
Time Zone [ {GMT-08.00) Pacific Time (US & Canada) B
Default NTP Sener [ (optional)
SettheTime oy [2002 =] Month [Dee =] Day [ =]
Hour [ 17 =] Minute IE Second IE

Firmware " Enabled & Disabled

Bt stan [Jan_=] [01 =] End [Jan =] [01 5]

System

JEIE L

Misc

Select the Time Zone from the pull-down menu.

NTP is short for Network Time Protocol. NTP synchronizes
computer clock times in a network of computers.
This field is optional.

To manually input the time, enter the values in these fields for the
Year, Month, Day, Hour, Minute, and Second. Click Set Time.

To select Daylight Saving time manually, select enabled or
disabled, and enter a start date and an end date for daylight
saving time.
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Using the Configuration Menu (continued)

Tools > System

D-Link

Building Networks for People

AirPlusG

802.119/2.4GHz Wireless Router

DiI-524 :
i UM Status____Help |
_

Save Settings To Local Hard Drive

| ' Admin Save |
I Time ) ]
Load Settings From Local H%rd Drive
rowse
: | |
System Load |
I Firmware

Restare To Factory Default Settings

]_ Restore
Misc. 4'

Help

The current system settings can be saved as a file onto the local hard drive. The saved
file or any other saved setting file can be loaded back on the Broadband Router. To
reload a system settings file, click on Browse to browse the local hard drive and locate
the system file to be used. You may also reset the Broadband Router back to factory
settings by clicking on Restore.

Save Settings to
Local Hard Drive- Click Save to save the current settings to the local Hard Drive.

Load Settings from
Local Hard Drive- Click Browse to find the settings, then click Load.

Restore to Factory
Default Settings-  Click Restore to restore the factory default settings.
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Using the Configuration Menu (continued)

Tools > Firmware

Dg I‘lnl,,( AirPlus G

802.119/2.4GHz Wireless Router

|__Home _ Advanceciilll "TERN Status  Help |

|

Firmware Upgrade

There may be new firmware for your DI-524 to improve functionality and perfarmance.
Click here to check far an upgrade on our support site.

To upgrade the firmweare, locate the upgrade file on the local hard drive with the Browse
button. Once you have found the file to be used, click the Apply button below to start the
firrmware upgrade.

I:ll-ﬁj24
S

]

T—‘:ﬂ

Current Firmware Version: 1.00
Firmware Date: Tue, 24 Dec 2002

Browse

ey

Firmware a Q o

Apply Cancel Help

i

You can upgrade the firmware of the Router here. Make sure the firmware you want
to use is on the local hard drive of the computer. Click on Browse to browse the local
hard drive and locate the firmware to be used for the update. Please check the D-Link
support site for firmware updates at http://support.dlink.com. You can download firmware
upgrades to your hard drive from the D-Link support site.

Firmware Upgrade- Click on the link in this screen to find out if there is an up-
dated firmware; if so, download the new firmware to your hard

Browse- After you have downloaded the new firmware, click Browse in

this window to locate the firmware update on your hard drive.
Click Apply to complete the firmware upgrade.
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Using the Configuration Menu (continued)

Ping Test-

Restart
Device-

Block
WAN
Ping-

UPNP-

Gaming
Mode-

Dynamic
DNS-

VPN
Pass
Through-

Tools > Misc
The Ping Test is used to
send Ping packets to test
if a computer is on the In-
ternet. Enter the IP Address
that you wish to Ping, and
click Ping.

AirPlusG

B802.11g9/2. 4GHz Wireless Router
[_tome _ Advancediiil VTR Status_ Help |
Fing Tl i wad 13 nd "Fing” packats 10 beat ¥ computi is on 1t bbarmat

|

|

!

Hest Mo & B
et

Feboats the DHE2Y

Click Reboot to restart the -

DI-524.

Witwn you “Block VAN Piny
00t respard ba ping comm:
method used by hackars 1o

ausing the public WAN P sddress an the DIS24
e IF addresses is & common

+HEEE

Diseard PING freem WaN pide © Enabisd & Diasbled

If you choose to block WAN
Ping, the WAN IP Address of
the DI-524 will not respond
to pings. Blocking the Ping
may provide some extra s
security from hackers.

Discard Ping from
WAN side- o

Click Enabled to block the
WAN ping.

& Enabled © Dvsabled

* Ensbied © Disabled

Alows VIT conaetions 1o wirk Theugh Th CHEI

 Enabled © Disabled
& Enabled © Disabled

DONS © Ensbied  Disabled

20

Cancel Kelp

1

To use the Universal Plug and Play feature click on Enabled. UPNP
provides compatibility with networking equipment, software and pe-
ripherals of the over 400 vendors that cooperate in the Plug and Play

Gaming mode allows a form of pass-through for certain Internet Games.
If you are using Xbox, Playstation2 or a PC, make sure you are using
the latest firmware and Gaming Mode is enabled. To utilize Gaming
Mode, click Enabled. If you are not using a Gaming application, it is
recommended that you Disable Gaming Mode.

Dynamic Domain Name System is a method of keeping a domain name
linked to a changing IP Address. This is a useful feature since many
computers do not use a static IP address.

The DI-524 supports VPN (Virtual Private Network) pass-
through for both PPTP (Point-to-Point Tunneling Protocol) and
IPSec (IP Security). Once VPN pass-through is enabled, there
is no need to open up virtual services. Multiple VPN connections
can be made through the DI-524. This is useful when you have
many VPN clients on the LAN network.

PPTP- select Enabled or Disabled

IPSec- select Enabled or Disabled
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Using the Configuration Menu (continued)

Status > Device Info

AirPlus(G

802.119/2.4GHz Wireless Router

DI-524
] Home  Advanced  Tools VTS Help |

Firmware Version: 1.00 , Tue, 24 Dec 2002

LAN
MAC Address 00-03-2F-FF-FO-85

1P Address 192168301
Subnut Mask 255.255.255.0

i
‘;’——
Device Info
. Log
DHCP Server Enabled
Stats
F

WAN
MAC Address 00-03-2F-FF-FO-86
Connection OHCP Clignt C 4  DHCP Relaasa DHCP Renew

IP Address 10.80.1.94
Subnet Mask 255000
Default Gateway 10.10.10,100
DNS 10.10.10.41 10.10.10.45 192.152.81.1

Wireless 802,119
MAC Address 006083 06.00-32

SSI0 GiGi

This page displays the current information for the DI-524. It will display the LAN, WAN,
and MAC address information.

If your WAN connection is set up for a Dynamic IP address then a Release button
and a Renew button will be displayed. Use Release to disconnect from your ISP and
use Renew to connect to your ISP.

If your WAN connection is set up for PPPoE, a Connect button and a Disconnect but-
ton will be displayed. Use Disconnect to drop the PPPoE connection and use Connect
to establish the PPPoE connection.

This window will show the DI-524’s working status:

LAN- IP Address: LAN/Private IP Address of the DI-524
Subnet Mask: LAN/Private Subnet Mask of the DI-524

WAN- IP Address: WAN/Public IP Address
Subnet Mask: WAN/Public Subnet Mask
Gateway: WAN/Public Gateway IP Address
Domain Name Server: WAN/Public DNS IP Address
WAN Status: WAN Connection Status

Wireless- MAC Address: Displays the MAC address
SSID: Displays the current SSID
Channel: Displays the current channel
WEP: Indicates whether WEP is enabled or disabled
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Using the Configuration Menu (continued)

Status > Log

Dg' I‘lnlf AirPlusG

802.11g9/2.4GHz Wireless Router

DI-524
o Home  Advanced Tools Status m

= \I-’i-e.wvl_uoéudisplays the activities occurting on the D524, Click on Log Settings for advance
features.
Device Info
First Page Last Page Preyious | et | Clearl Log Settings | Help
Log page 1 of 1
Tirne Message Source Destination Mote
e Dec/27/2002 17:09:11  DHCP Eequest success 10.80.1.94
Stats Dec/27/2002 17.09:11 DHCP Eequest 10.80.1.94
Dec/27/2002 17.09:11  DHCP Discover

Dec/27/2002 17:09:07  System started
T Wireless Dec/27/2002 17:09:07 DHCF Discover

The Broadband Router keeps a running log of events and activities occurring on the
Router. If the device is rebooted, the logs are automatically cleared. You may save the
log files under Log Settings.

View Log- First Page - The first page of the log.
Last Page - The last page of the log.
Previous - Moves back one log page.
Next - Moves forward one log page.
Clear - Clears the logs completely.
Log Settings - Brings up the page to configure the log.
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Using the Configuration Menu (continued)

Status > Log > Log Settings

D-Link AirPlusG’

802.119/2.4GHz Wireless Router

DI-524
T Home Advanced  Tools status T
‘—/—:,' Loy settings
R —— Logs can be saved by sending it to an admin email address.
[e—
Device Info
SMTP Setvet / 1P Address |
Log Email Address [ Send Mail MNow
= Log Type ¥ System Activity
= s [~ Debug Information
Stats 5
¥ Attacks
[E— [T Dropped Packets
Je——
Wireless ¥ MNatice

9 OO0

Apply Cancel Help

Not only does the Broadband Router display the logs of activities and events, it can
setup to send these logs to another location.

SMTP Server/

IP Address - The address of the SMTP server that will be used to send the
logs.
Email Address -

The email address to which the logs will be sent.
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Using the Configuration Menu (continued)
Status > Stats

D-Link AirPlusG

802.119/2.4GHz Wireless Router

o3l Home  Advanced  Tools status TN

Traffic Statistics

Traffic Statistics display Receive and Transmit packets passing through the DI-524.

.Devlcelnfo- Refresh | Reset | O

1l

Help
Log Receive Transmit
WAN 3964 Packets 277 Packets
LAN 1317 Packets 2321 Packets
Stats WIRELESS 119 553 Packets 0 Packets
\'#
Wireless

The screen above displays theTraffic Statistics. Here you can view the amount of
packets that pass through the DI-524 on both the WAN and the LAN ports. The traffic
counter will reset if the device is rebooted.

Status > Wireless

D-Link

Building Metworks for People

AirPlusG

802.11g9/2.4GHz Wireless Router

T Advanced O Help |

- — The Wireless Client table below displays Wireless clients Connectad to the AP o
I [Access Point). Help

Device Info
Connected Time MAC Address Mode

I Log

T

Stats

Wireless

The wireless client table displays a list of current connected wireless clients. This
table also displays the connection time and MAC address of the connected wireless
client.

Click on Help at any time, for more information.
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Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.
Note: Please refer to websites such as http./www.homenethelp.com
and http://www.microsoft.com/windows2000 for information about networking
computers using Windows 2000, ME or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Metwork Setup Wizard

Welcome to the Network Setup
% Wizard

Thiz wizard will help you set up this computer bo run on your
nebwork. With a nebwork pou can:

Share an Internet connection

Set up Internet Connection Firewall
Share fles and folders

Share a printer

To continue, click Meut,

When this screen appears, Click Next.
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Networking Basics

Please follow all the instructions in this window:

Metwork Setup Wizard
Before you continue.._.

Before you continue, review the Shecklist for creating a networks.

Then, complste the following steps:

*+ |nstall the network cards, modems, and cables.

+ Turn on all computers, printers, and external modems.
+ Connect to the Internet,

“when pou click Mest, the wizard will search for a shared Intemet connection on your network.

’ < Back Il Mext = Il’ Cancel ]

Click Next

In the following window, select the best description of your computer. If your computer
connects to the internet through a gateway/router, select the second option as shown.

Network Setup Wizard

Select a connection method.

Select the statement that best describes this computer:

() This computer connects directly to the Intemet. The other computers on my network. connect
to the Internet through this computer.

Wiew an example.

(=) Thiz computer connects ta the Intemet through anather computer an my network or thraugh
a residential gateway.

Wiew an example.

O

Learn more about home or small office netwark configurations.

< Back [ Mest » J" Cancel

Click Next
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Networking Basics

Enter a Computer description and a Computer name (optional.)

Click Next

Network Setup Wizard
Give this computer a description and name.

(Qomputer descriphion: | Mary's Computer |)

Examples: Family Foom Computer or Monica's Computer

(Egmputer narme: | Office _ |)
Examples: FAMILY or MOMICA

The current computer name is Office

Learn more about computer names and descriptions.

< Back l Mest » ' Cancel

Enter a Workgroup name. All computers on your network should have the same
Workgroup name.

Click Next

-
Network Setup Wizard

Mame your network.

Mame pour netwark by specifying a workgroup name below. All computers on vour network
should have the zame workgroup name.

Workgroup name: | Accounting | |
Examples: HOME ar OEFICE

< Back Ment » Cancel
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Networking Basics

Please wait while the Network Setup Wizard applies the changes.

Network Setup Wizand

Ready to apply network settings. .

The wizard will apply the following settings. This process may take a few minutes to complete
and cannot be interupted,

Metwork settings:

Computer name: Office
“Workgroup name: Accounting

The Shared Diocuments folder and any printers connected to thiz computer have been
shared.

|

Computer description: Many's Computer ‘
[

|

To apply theze zettings, click Next.

e
[ < Back I_ MNext » J'[ Cancel ]

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.

Metwork Setup Wizard

Please wait._.

Flease wait while the wizard configures this computer for home or zmall office netwarking. This
process may take a few minutes.

5 B,




Networking Basics

In the window below, select the option that fits your needs. In this example, Create
a Network Setup Disk has been selected. You will run this disk on each of the

computers on your network. Click Next.

Network Setup Wizard
You're almost done...

® \ YWouneed to run the Mebwork Setup wWizard once on each of the computers on your
\E) netwark. To n the wizard on computers that are not rnning Windows XP. vou can uze
the Windows <P CD or a Metwork Setup Disk.

“what do you want to do?

(®)iCreate a Netwark Setup Diski

() Use the Netwark Setup Disk | already have
(0 Use my Windaws xP CD

() Just finizh the wizard; | don't need to un the wizard on other computers

e ]

Insert a disk into the Floppy Disk Drive, in this case drive A.

[ Rl

Network Setup Wizard

Ingert the disk you want to use.

Insert a dizk the into the following disk dive, and then click Nest.

3 Flappy [4:)

If you want to format the disk, click Format Disk.

Click Next.
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Please wait while the Network Setup Wizard copies the files.

Copying...

< =

Flease wait while the wizard copies files. ..

]| Cancel |

Please read the information under Here’s how in the screen below. After you com-
plete the Network Setup Wizard you will use the Network Setup Disk to run the
Network Setup Wizard once on each of the computers on your network. To continue

Metwork Setup Wizard

To run the wizard with the Hetwork Setup Disk._. %

2 Complete the wizard and restart this computer. Then, use the Metwork Setup Digk to run
\:!-l) the Metwork, Setup ‘Wizard once on each of the other computers on pour network:,

Here's how:
1. Inzert the Hetwork Setup Dizk into the nest computer pou want to netwark.

2. Open My Computer and then open the Metwark, Setup Disk.
3. Double-click "netsetup.”
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Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.

Network Setup Wizand

Completing the Network Setup
Wizard

You have successfully et up this computer Far home ar small
office networking.

Far help with home or small office networking, see the
following topics in Help and Support Center:

+ Uzing the Shared Documents folder

To zee other computers on your nebwork, click Start, and then
click My Metwork Places.

To close this wizard, click Finish.

< Back Finish |

The new settings will take effect when you restart the computer. Click Yes to restart
the computer.

System Settings Change

| ves | ’ Mo

You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network

Setup Disk on all your computers, your new wireless network will be ready to use.
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Networking Basics
Naming your Computer

To name your computer, please follow these directions:In Windows XP:

B Click Start (in the lower left corner of the screen).
m Right-click on My Computer.

W Select Properties and click.

Internet _._) My Documents
Internet Explorer

=
@™ E-mail <) My Recent Documents b
Outlook Express

:‘:( My Pictures

[ " orrirnand Prompt =h My Music
\3 MM Explorer 6-" Fiy Lomputes
= Open
. . ‘g My Network  Explore
‘Windows Media Player search...

¥ B’ Contral Pang|  Manage
‘o Bl Windows Movie Maker

e Map Metwork Drive. ..
-, Ga A Disconnect Metwork, Drive...

@ Tour Windows XP ),
J\:a Printers and - Show on Deskkop

| Files and Settings Transfer | Rename

o ikt @) e znd SUW

System Properties |E| [z|

B Select the Computer —
Name Tab in the System | SustemFie:
Properties window. Gereral |

fic Updates | Remate
| Hardware | Advanced

Windaws uzes the Following information to identify wour computer
on the network.

Computer description:

B You may enter a

For example: "Kitchen Computer or "Marny's

Computer Description Computer”.

if you WISh, this field is Full computer name:  Office

optlonal. arkgroup: Accounting
To uze the Metwork |dentification ‘Wizard to join a
domain and create a local uzer account, click Mebworl, Hetwork 1D
ID.

B To rename the computer
and Join a domam- Click To renamne this computer or join a domain, click Change.
Change.
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Naming your Computer

M |n this window, enter the
Computer name.

B Select Workgroup and enter
the name of the Workgroup.

B All computers on your
network must have the same
Workgroup name.

B Click OK.

Computer Name Changes

“r'ou can change the name and the membership of thiz
computer. Changes mav affect access to netwark resources.

Compiter name;
| Office

Full computer name:

Office

More. .

Member of
() Domair:

i |
(=) Workaroup:

! Accounting |

‘ OK ' Cancel

Checking the IP Address in Windows XP

The wireless adapter-equipped computers in your network must be in the same IP Ad-
dress range (see Getting Started in this manual for a definition of IP Address Range.)
To check on the IP Address of the adapter, please do the following:

B Right-click on the Disable
Local Area Con-

nection icon in the

REnal
task bar. i

M Click on Status.

Yiew dvailable Wireless Metwaorks

Cpen MNebwork Connections
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Checking the IP Address in Windows XP

This window will appear. Wireless Metwork Connection F Status

General |‘ Suppart D

Internet Protocol [TCRAIR)

[ | Click the Sup-

port tab Addrezs Type: Agzzigned by DHCP
(1P adiress 1921680114 |

Subriet bask: 255, 255.255.0

Default Gateway: 132168.0.1

getaﬂg

[ ] Click Close

' LClose

Assigning a Static IP Address in Windows XP/2000

Note: Residential Gateways/Broadband Routers will automatically assign IP Addresses
to the computers on the network, using DHCP (Dynamic Host Configuration Protocol)
technology. If you are using a DHCP-capable Gateway/Router you will not need to
assign Static IP Addresses.

If you are not using a DHCP capable Gateway/Router, or you need to assign a Static
IP Address, please follow these instructions:

5 |l" Control Panel
Tour Windows %P { -l oS S
B Goto Start @ =
Eﬁ Printers and Faxes
.| Files and Settings Transfer =
Wizard
9) Help and Support
"y Painkt -
u Double-click on y-) Search
Control Panel
All Programs D EZ? Run...

ﬂ] Liog Cff F5| Turn OFF Computer

4 start
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Assigning a Static IP Address in Windows XP/2000

B Contral Panel

Fil=  Cdt Miew Favorites Tools Help
Qo © B Powa o
Ao [ ot -
-B"/ Control Panel b3
on Network :
Connections '
" Network Conneclions
File FEdt  Wiew Favoites  Tools  Advanced  Help
Qo - ) ¥ DOsewch |7 rodes [T
Address [, Nabwork Connections )
A Name
Metwaork Tasks & LAN or High-Speed Internet
spmr | GEED
. . [ wan Disabie
B Right-click on Local Area B Sotop et Shbes
Connections ot |

Q, fepar this connaction
Y Rename the conection

W Wiew status of this
CORNBLLION

[&@] Thanpe settings of this
connaction

B Double-click on
Properties

4 iew or change seltings for this connection, such as adapter, protucol, o mdem configur
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Assigning a Static IP Address

'.n WindOWS XP/2000 _ Local Area Connection 2 I'roportics
‘Goverd | Advarced

Carmec: Liing

B Click on Internet Protocol B} D.Unk DWL-2650
(TC PIIP) Zonligre .
Tz connechon uies b foloming ke
B Click PrOpertles ¥ 1Bl Clan o Micrasck Menweres

l nalal. | l Mooeri=s

B Input your IP address and

LCr=eacr plion
SUbnet maSK' (The IP Tirrznizsi v "onh AP Lo ol aleir el Pooooe d T wi-ol
Addresses on your network wice ors cheoll Erotosol bk prosices cammuaicaie
must be Wlthln the same Ecioss dwerse ineconteched rebaoks
range. For example, if [ Slowe icon in nodfizet on ares wherr zoninested

one computer has an IP
Address of 192.168.0.2,
the other computers should [ e [ rew
have IP Addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The subnet
mask must be the same for

R teomputers on the
Internet Protocol (TCP/IP) Properties ?
network.) () Eor )

General |
Select Use the fo"OWing Yglu can get IF settings assigned automaticaly if your r'etmrk_suppoﬁx
. this capability. Otherwise, pou need to ask your network admiristratar for

IP address in the Internet the appropriate IP settings.

Protocol (TCP/IP) Properties P —

window (shown below) (@ sz the folloving IP adess:)

1M address: [122 160, 0 . 2 |

Input yOUr DNS server Subnet mask: 205 . 256 &5, 0

addresses. (Note: If you Betal ordenw:

are entering a DNS server, s o

you must enter the IP (© e the folloning DNS server addresses:)

Address of the Default Brefenied DNS server [

Gateway.) Alternate DMS server:
The DNS server information will be supplied ;
by your ISP (Internet Service Provider.) [ concel |

Click OK

50



Networking Basics

Assigning a Static IP Address with Macintosh OSX

B Gotothe Apple Menu and select

System Preferences

B Click on Network

B Select Built-in Ethernetin the
Show pull-down menu

m SelectManually inthe Con-
figure pull-down menu

B |nputthe Static IP Address,
the Subnet Mask and the
Router IP Address in the
appropriate fields

Bl Click Apply Now

ao PORp—
M BEA0 8

Parsonal

S e my s S
I-E. u..g. Froven
[-XG] Network =)

« "800 @

ShowAll | Displays Sound Network Startup Disk

Location: | Automatic

Show: | PCI Ethernet Slot C1 ]

Configure + Using DHCP
Using BootP

M Servers (Optionall

IP Address: 192.168.10.7
(Previded by DHCP Servert

Subnet Mask: 255.255.255.0

Router: 192.168.10.1

DHCP Client ID: — ]

IDptianal)

Ethernet Address: 00:50:bab0.00:05

Jesich Comalng Sgcone)

Example: apple.com, earthlink net

@

(@) Click the hock 1o prevent ol g v ssin e o 4 o/ 4@
8o Nemwork [==)
« = a@ 43
Sheowe Al Displays Sound  Neowork  Starmup Disk
Location: | Automatic i)
Show: | PCI Ethernet Slot C1 )

frerie Y rerot | AppleTalk | Proxies |

Configure: | Manually

IP Address: 192

Subnet Mask: 2

Ethernet Address: 00:50:ba:b0.00:05

(@) Click the lock to prevent fu b S

i)

Domain Name Servers Dotional)

Search Domaing (Dgtienall

Example: apple.com, earthlink met

27 4w

51




Networking Basics

Selecting a Dynamic IP Address with Macintosh OSX

B Go to the Apple Menu and select e

System Preferences

Bl Click on Network

B Select Built-in Ethernet in the

Show pull-down menu

B Select Using DHCP in the
Configure pull-down menu

B Click Apply Now

B The IP Address, Subnet
mask, and the Router’s IP
Address will appear in a few
seconds

A=) T TR
2 B2s0 .8
Parsonal
W | ® 1
y = 0 () Y
@ -
s
an @ [ G
@

[Z)E] Nerwork [=]

« 500 03

Show AN Duplays Sound Metwork Startup Disk

Location: | Automatic ™

Show: | Built-in Ethernet B
——— e —
J Manually Toies

aQuCRE

@I~ Uting OHCP )

ame Servers (Dgtisnal)

1P Address:
Previded by OHCP Server)

Subnet Mask: 255.255.255.0

Router- 1921680 Search Domaing (Opsionaly

DHCP Client 1D

Opaioast)

Example; apple.com, sarthlink.net
Ethernet Address.

ot

(W) Click the lock to prevent further changes.

ee Network =

« = 4@ 3

Shera All D|.lll|i¥! Sound Network  Startue Disk
Location; | Automatic s

Shaw: | PCI Ethernet Shot C1 i)
[FrEPnP) pprot | AmpleTalk | Proxies |

Configure: | Manually (53]

Domain Name Servers (Opdonal)

IP Address. 192.168.0.19 |
Subnet Mask: 2552552550 |

Router- |192.168.10.1 Search Domains ACptnall

Example- apphe com, earthlink net
Ethernet Address. 00:50.ba-b0.00.05

& Click the lock to prevent u i g 45 S o 0 7 4
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Networking Basics
Checking the Wireless Connection by Pinging in Windows XP and
2000

B Goto Start > Run > BErEsSe e
type cmd. Awindow £ ' g
similar to this one
will appear. Type
ping XXX.XXX.XXX.
XXX, where xxx is
the IP Address of
the Wireless Router
or Access Point. A
good wireless con-
nection will show
four replies from
the Wireless Router
or Acess Point, as
shown.

Checking the Wireless Connection by Pinging in Windows Me and
98

B Go to Start > Run WINDOWS\System32\cmd exe
> type command. €
A window similar
to this will appear.
Type ping XXX.XXX.
XXX.XXX where xxx
is the IP Address
of the Wireless
Router or Access
Point. A good wire-
less connection will
show four replies
from the wireless
router or access
point, as shown.
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DI-524 Wireless Broadband Router. We cover various aspects of the
network setup, including the network adapters. Please read the following if you are
having problems.

Note: It is recommended that you use an Ethernet connection to
configure the DI-524 Wireless Broadband Router.

1.The computer used to configure the DI-524 cannot access the
Configuration menu.

B Check that the Ethernet LED on the DI-524 is ON. If the LED is not
ON, check that the cable for the Ethernet connection is securely

inserted.

B Check that the Ethernet Adapter is working properly. Please see item
3 (Check that the drivers for the network adapters are installed
properly) in this Troubleshooting section to check that the drivers

are loaded properly.

B Check that the IP Address is in the same range and subnet as the
DI-524. Please see Checking the IP Address in Windows XP in

the Networking Basics section of this manual.
Note: The IP Address of the DI-524 is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.

Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

m Do a Ping test to make sure that the DI-524 is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.1. A successful

ping will show four replies.

MDOWS\System 32 \emd. exe

Note: If you have
changed the default IP
Address, make sure to
ping the correct IP Ad-
dress assigned to the
DI-524.
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Troubleshooting

2. The wireless client cannot access the Internet in the

Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection
icon in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

Disable
Status
Repair

Open Metwork Connections

Connect to Wireless Network

The following network(s) are avalable. To access a netwark, select

it from the kizt, and then chck Connect
Avalable networks:

§ alan

If you are having difficulty connecting to a network, click Advanced

)

Advanced I | Connect ]l

Cancel

B Check that the IP Address assigned to the wireless adapter is within
the same IP Address range as the access point and gateway. (Since
the DI-524 has an IP Address of 192.168.0.1, wireless adapters must
have an IP Address in the same range, e.g., 192.168.0.x. Each device
must have a unique IP Address; no two devices may have the same IP
Address. The subnet mask must be the same for all the computers on
the network.) To check the IP Address assigned to the wireless adapter,
double-click on the Local Area Connection icon in the taskbar >
select the Support tab and the IP Address will be displayed. (Please
refer to Checking the IP Address in the Networking Basics section of

this manual.)

B [fitis necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you
are entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable

router, you will not need to assign a Static IP Address. See Networking
Basics: Assigning a Static IP Address.)
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Troubleshooting

3. Check that the drivers for the network adapters are

installed properly.

You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are

using.

m Go to Start >
My Computer >
Properties.

m Select the
Hardware
Tab.

B Click Device
Manager.

W ]
Open

q pm  Explore

SR (_omimiand Prompk

wEL Windows Movie Maker Search...
Manage
B
M3M Explorer Map Metwork Drive..,

},_é Pr; Disconnect Metwark Crive,..
‘Windows Media Plaver

'@ Tour Windows P

All Programs D

@
Y
®

Show on Desktop

Sysiem Proparties ﬁ‘ll:ifl
System Aeshore Atatoim e Femote.
Giersal Compuber M ames Advarcad
Mydd Handwars 'Wizad
'I.'E The Bdd Hardwars Wizard helps you irstal hardwans
[ fod Hardware Wizeed

Dienvican Wanage:

Tha Devica Manages [zt ol e hardwase devaces installed
an poul compubat. Uies the Device Manager 1o change the

piopetie: ol sy P
l Coriwar Sigring ] S Diovvice Manages Z
Hadwae Prohle:

Hardeare profiles provide a vwap for pou ho 3ot up and o
difesant hasdwsane: combiguiations.

| HadwseProies |

[ |[ ceca |




Troubleshooting

B Double-click
on Network
Adapters.

B Right-click on D-Link
AirPlus DWL-G650
Wireless Cardbus
Adapter (In this example
we use the DWL-G650;
you may be using other
network adapters, but
the procedure will remain
the same.)

B Select Proper-
ties to check that
the drivers are
installed properly.

B Look under Device
Status to check that the
device is working

properly.

B Click OK.

File Action ‘View Help

WS @ 4 =&

=2 PMTEST
+ H, Batteries
+ } Computer
+ g Disk drives
+ g Display adapters
+ (=) Floppy disk controllers
+ M Floppy disk drives
+ () IDE ATAJATAPT controllers
+ < Keyboards
+ ) Mice and other pointing devices
+ L Madems
+- 7@ Monitors

#3 Nebwork adapters

(71 D-Link AirPlus DWL-650
+ B PCMCIA sdapbers
+ Y Ports (COM&LPT)
£ R Processors
+ @, sound, video and qame controllars
&
¥

System devices
Uinkversal Serial Bus contrallers

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

PX

General |Advanced: Diriver | Resources |

D-Link AirPlus DWL-650 Wireless Cardbus Adapter
{

R

[ evice type: Metwork adapters
M anufacturer: D-Link
Location: FCI bus 129, device 0. function 0

Dewice status

Thiz device iz working properly.

If you are having problems with thiz device, click Troubleshoot to
start the troubleshooter.

Device usage:

Troubleshoat...

' Uze thiz device [enable]

6|

)
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Troubleshooting

4. What variables may cause my wireless products
to lose reception?

D-Link products let you access your network from virtually anywhere you want. How-
ever, the positioning of the products within your environment will affect the wireless
range. Please refer to Installation Considerations in the Wireless Basics section
of this manual for further information about the most advantageous placement of your
D-Link wireless products.

5. Why does my wireless connection keep dropping?

B Antenna Orientation- Try different antenna orientations for the DI-524. Try to
keep the antenna at least 6 inches away from the wall or other objects.

W If you are using 2.4GHz cordless phones, X-10 equipment or other home se-
curity systems, ceiling fans, and lights, your wireless connection will degrade
dramatically or drop altogether. Try changing the Channel on your Router, Ac-
cess Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

If you have enabled Encryption on the DI-524, you must also enable encryption on all
wireless clients in order to establish a wireless connection.

B For 802.11g, the Encryption settings are: 64 or 128 bit. Make sure that the en-
cryption bit level is the same on the Router and the Wireless Client.

B Make sure that the SSID on the Router and the Wireless Client are exactly the
same. If they are not, wireless connection will not be established.

B Move the DI-524 and the wireless client into the same room and then test the
wireless connection.

B Disable all security settings. (WEP, MAC Address Control)
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Troubleshooting

6. Why can’t | get a wireless connection? (continued)

Turn off your DI-524 and the client. Turn the DI-524 back on again, and then
turn on the client.

Make sure that all devices are set to Infrastructure mode.

Check that the LED indicators are indicating normal activity. If not, check that
the AC power and Ethernet cables are firmly connected.

Check that the IP Address, subnet mask, gateway, and DNS settings are cor-
rectly entered for the network.

If you are using 2.4GHz cordless phones, X-10 equipment or other home se-
curity systems, ceiling fans, and lights, your wireless connection will degrade
dramatically or drop altogether. Try changing the Channel on your DI-524, and
on all the devices in your network to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

7. | forgot my encryption key.

Reset the DI-524 to its factory default settings and restore the other devices on
your network to their default settings. You may do this by pressing the Reset

button on the back of the unit. You will lose the current configuration settings.
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Troubleshooting

8. Resetting the DI-524 to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the DI-524 to the factory default settings. Remember that D-
Link AirPlus G products network together, out of the box, at the factory default
settings.

Reset
To hard-reset the DI-524 to Factory Default Settings, please do the following:

B | ocate the Reset button on the back of the DI-524.
B Use a paper clip to press the Reset button.

B Hold for about 10 seconds and then release.

m After the DI-524 reboots (this may take a few minutes),
it will be reset to the factory Default settings.
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Technical Specifications

Standards
m |EEE 802.119g
B |EEE 802.11b
m |EEE 802.3
m |EEE 802.3u

VPN Pass Through/ Multi-Sessions
m PPTP
B L2TP
m [PSec

Device Management

B Web-Based- Internet Explorer v6 or later; Netscape Navigator v6
or later; or other Java-enabled browsers

B DHCP Server and Client

Advanced Firewall Features

m NAT with VPN Passthrough (Network Address Translation)
MAC Filtering
IP Filtering
URL Filtering
Domain Blocking
Scheduling
Wireless Operating Range
B Indoors — up to 328 feet (100 meters)
m Outdoors — up to 1312 feet (400 meters)
Operating Temperature
B 32°F to 131°F (0°C to 55°C)

Humidity:
B 95% maximum (non-condensing)

Safety and Emissions:
m FCC

Wireless Frequency Range:
B 2.4GHzto 2.462GHz
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Technical Specifications

LEDs:

Power

WAN

LAN (10/100)

WLAN (Wireless Connection)

Physical Dimensions:

m L=5.6inches (142mm)
m W =43 inches (109mm)
m H=1.2inches (31mm)

Wireless Transmit Power:
m 15dBm 72dB

Security:

B 802.1x
B WPA- WiFi Protected Access
(WEP with TKIP, MIC, IV Expansion, Shared Key Authentication)

External Antenna Type:
B Single detachable reverse SMA

Modulation Technology:
m Orthogonal Frequency Division Multiplexing (OFDM)

Power Input:
B Ext. Power Supply DC 5V, 2.5A

Weight:
B 7.80z. (0.22kg)
Warranty:

m 3year
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Technical Specifications
Wireless Data Rates* with Automatic Fallback:

54 Mbps
48 Mbps
36 Mbps
24 Mbps
18 Mbps
12 Mbps
11 Mbps
9 Mbps
6 Mbps
5.5 Mbps
2 Mbps
1 Mbps

Receiver Sensitivity:

54Mbps OFDM, 10% PER, -68dBm
48Mbps OFDM, 10% PER, -68dBm
36Mbps OFDM, 10% PER, -75dBm
24Mbps OFDM, 10% PER, -79dBm
18Mbps OFDM, 10% PER, -82dBm
12Mbps OFDM, 10% PER, -84dBm
11Mbps CCK, 8% PER, -82dBm
9Mbps OFDM, 10% PER, -87dBm
6Mbps OFDM, 10% PER, -88dBm
5.5Mbps CCK, 8% PER, -85dBm
2Mbps QPSK, 8% PER, -86dBm
1Mbps BPSK, 8% PER, -89dBm

*Maximum wireless signal rate based on IEEE Standard 802.11g specifications. Actual data throughput will
vary. Network conditions and environmental factors, including volume of network traffic, building materials
and construction, and network overhead lower actual data throughput rate.
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-524 (192.168.0.1), you are not connecting to
the Internet or have to be connected to the Internet. The device has the utility built-in
to a ROM chip in the device itself. Your computer must be on the same IP subnet to
connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device.
If you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/’XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What's the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two
types of cable have different purposes
for different LAN configurations. EIA/TIA

) .. 1 White-Green
568A/568B define the wiring standards 2 Green
and allow for two different wiring color ] Bhite-Orange
codes as illustrated in the following g ‘(-;‘-:féisgflue
d*ia ram. . 7 White-Brown
e wires with colored backgrounds may 8 Brown
have white stripes and may be denoted 5684 CABLE END
that way in diagrams found elsewhere. 12 White-Orange
. Orange
How to tell straight-through cable from 3 White.Green
a crossover cable: g E}ﬂ?te Blue
The main way to tell the difference 6 Green
between the two cable types is to % White-Brown

compare the wiring order on the ends
of the cable. If the wiring is the same on
both sides, it is straight-through cable. If one side has opposite wiring, it is a
crossover cable.

5688 CABLE END

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable

is important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover

Hub/Switch uplink port to another Hub/Switch normal port - Straight-through5



Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Step 3 Configure your Internet settings.

Go to Start>Settings>Control Panel. Double
click the Internet Options Icon. From the Security
tab, click the button to restore the settings to their
defaults.

Click to the Connection tab and set the dial-
up option to Never Dial a Connection. Click

the LAN Settings button.

Nothing should be checked. Click OK.

Go to the Advanced tab and click the
button to restore these settings to their

defaults.

Click OK. Go to the desktop and close any open
windows.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the
same range of the device you are attempting to configure. Most D-Link devices use
the 192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as
shown then click OK.

Run

Tupe the name of a prograrn, falder, or document, and
Windows will open it for pau.

Open: |winipcfg j

0k i Cancel | Browse... |

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

B Select your adapter from the drop down menu.
M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

I Configuration M= E3

— Ethemet Adapter [ntormation

R r——
Adapter Address TR0

IF Address 0000
Subnet bask ININTAT]
Defaul Gateway

ak I Fielease | Fremen |

Fielease Al | Fienew All | More Info > |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5 Click OK to close the IP Configuration window.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address

in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.

Step 2 Type cmd then click OK.
Run @ o

= Twpe the name of a program, Folder, document, or
- Internet resource, and Windows will open it Faor you,

Qpen: [ cmd | %

[ K H Cancel H Browse, .. J

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway.

@ IP Configuration

Ethernet adapter Local Area Connection:

Step 4 Type exit to close the command prompt.

68



Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP
Address in the same range of the device you are attempting to configure. Most D-
Link devices use the 192.168.0.X range.

Make sure you take note of your computer’s Default Gateway IP Address. The
Default Gateway is the IP Address of the D-Link router. By default, it should be
192.168.0.1.

How can | assign a Static IP Address in Windows

Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.
How can | assign a Static IP Address in Windows

&Qg-a«ight—click on My Network th 13 o re Dok pod 0

ik - o - ()| Dsewch Difdin J H W X 0| IF

Places and select Properties. st B v
v U H U %
Step 2 Right-click on the Local Network and Distup . i [
Area Connection which represents U
your network card and select —
Properties. e :
Local area Connection Properties 2
Generd |
Conrmeed warsy.
[B DeLank. DFES30TX PO Fast Ethesnet Adaples
| Locfgen I

Componerts checked are uted by this connechion:

Highlight Internet Protocol (TCP/ |
IP) and click Properties. . J:i
ol ueeal | Popesies |
e Conlred F olocol The delaul
[¥ Shap icon in taskbar when connected
L =
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows
20007 (continued)

Click Use the following IP Address and  prerswreyrsr———— i
enter an IP Address that is on the same enesd |
subnet as the LAN IP Address on your Vot can g IPstings avsned sty you vk s
router. Example: If the router’s LAN IP boowppnde Fese.
Address is 192.168.0.1, make your IP € Qbtain an IP address automaticaly
Address 192.168.0.X where X = 2-99. S —
Make sure that the number you choose ST N
is not in use on the network. Defauh gateway: (75 76 6. 1
Set the Default Gateway to be the || Usgthe foonng DIG serves adgesses
same as the LAN IP Address of your P s ,%
router (192.168.0.1). B

Advanced...
Set the Primary DNS to be the same —

as the LAN IP address of your router
(192.168.0.1).

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click
Yes.

How can | assign a Static IP -
Address in Windows 98/Me? P e e

The lollowng netwark components aie nstallad
(=81 Clhert fon Microrolt Netweoks

Step 1 From the desktop, right-click on the D-Lok DIE S3UEPO Fan EharatAdepter ey )
Network Neigborhood icon (Win ME - My

Network Places) and select Properties.

Add. | Remove | Propenss |
Prinnaey Metwork Logon:
Highlight TCP/IP and click the Properties Ckert o Mitocat Ntwod =
button. If you have more than 1 adapter, _ Beadpitshory |
then there will be a TCP/IP “Binding” [Teepis e
for each adapter. Highlight TCP/IP > e
(your network adapter) and then click
Properties. (e S|
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in
Windows 98/Me? (continued)

(1P Propenies G |

Step 2 Click Specify an IP Address. =

Enter in an IP Address that is on the same ﬁ*'mmmmmmy

subnet as the LAN IP Address on your

router. Example: If the router’s LAN IP e

Address is 192.168.0.1, make your IP 1P Adsess

Address 192.168.0.X where X is between Subem ok (755755 755 1

2-99. Make sure that the number you choose

is not in use on the network.

Step 3 Click on the Gateway tab.

TCHAIF Properties

Enter the LAN IP Address of your router

| bemios
Mstwﬂum Gatewsy | WING Corfipueation | P Addess

here (192.168.0.1). Py
1% Enabie NS
Moot [y Dgmar [
Click Add when finished. 05 San
'I!Z 168. 0 1 I
Step 4 Click on the DNS Configuration tab.
Click Enable DNS. Type in a Host (can _I
be any word). Under DNS server search
order, enter the LAN IP Address of your e e
router (192.168.0.1). Click Add.
[1cae Pupeies |
Mm |ﬁmﬂmsml "i.;ﬂmzﬁm
Step 5 Click OK twice. e
When prompted to reboot your computer, Hod [aien D |
click Yes. . DN |
After you reboot, the computer will now T |
have a static, private IP Address. —
|
[ ||
Step 5 Access the web management. Open your web

browser and enter the IP Address of your D-Link device in o | e |
the address bar. This should open the login page for the

web management. Follow instructions to login and complete the configuration.
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(IE AT&T-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based configuration by typing in the IP Address of the
router (default:192.168.0.1) in your web browser. The username is admin (all

lowercase) and the password is blank (nothingEErrr 2ix
-?> Flaase ype ypour user name and password.

Step 2 Click the Home tab and click the i 1216301

WAN button. Dynamic IP Address is the Resn D

default value, however, if Dynamic IP Address Uses Name [admn

is not selected as the WAN type, select Basswoed [

Dynamic IP Address by clicking on the radio ™ Save this password in o password it

button. Click Clone Mac Address. Click Concel |

on Apply and then Continue to save the

changes.

D-Link

Building Networks for People

AirPlusG

802.119/2.4GHz Wireless Router

[0 -0 Advanced  Tools Status Help__

T-——.z Please select the appropriate option to connect to your ISP.
Wizard
@ Dynamic [P Address Chooge thiz option to obtain an IP address automatically

from your ISP. (For most Cable modem users)

Wircless " Static IP Address Choose this option to set static IP information provided to
you by your ISP,
 PPPoE Choose this option if your 1S uses FPPoE. (For most
DSL users)
WAN € Others PPTP and BigPond Cable
- © pPpPIP (for Europe use only)
LAN Dynamic 1P
— Host Mame IDI-524 {optional)
MALC Addrase
™ Dhce o 1. .pF .FF_.[m .
53 i Clone MAC Address |

Apply Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

Turn the cable modem off (first). Turn the router off Leave them off for 2 minutes.**
Turn the cable modem on (first). Wait until you get a solid cable light on the cable
modem. Turn the router on. Wait 30 seconds.

** If you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the
Status tab and click the Device Info button. If you do not already have a public IP

Address under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection
Step 1 Log into the web based configuration by typing in the IP Address of the
router (default:192.168.0.1) in your web browser. The T
username is admin (all lowercase) and the password

is blank (nothing). R

v Nam [odn

Bumwed [

™ Gave #his paserwond in your patireord et
Step 2 Click the Home tab and click the WAN I |
button. Select Static IP Address and enter your
static settings obtained
from the ISP in the fields

provided.

2=l

'?) Plaaze hupe your uter name and pattward.
Sn 13216801

D-Link

AirPlusG
802.119/2.4GHz Wireless Router

e g ———— Tl

If you do not know your i Pt - — —
settings, you must contact ®— s Lo — -
OU r IS P- - — Please select the sppropriste option to connect to your ISP,
y ) Dynamic 1P Addewss Choose It optean Lo oblam an P addoess aulomalsally
from your ISP, ([For most Cable modern weers)
. _}' & Stalic IP Addiess Choose this uElhun Lo sed stlic [P sigernation prowdied 1o
Step 3 Click on Apply and yDy Jok
) . O PRROE Choase this ogtion if your ISP uses PPPoE. (For most
then click Continue to save [7‘_ b DSLuse).
th h WAN | 0 Crtherg PPTP and BigPaond Cable
ec anges ' O PPTP {for Europe use only)
Step 4 Click the Status - P Address 0000 (assigned by your ISP
tab and click the Device Subnet sk ()
Info button. Your IP Address ISP Gatoway Addess (0000
information will be displayed Pyt (000
under the WAN headlng . Secondary DNS Address 0.000 (optional) b
@ &0
Apply Cancel Help

73



Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into
the address window and hit the Enter key. When the password dialog box appears,
enter the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run the Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 In the username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,

please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an |IP Address.

Can | use my D-Link Broadband Router to share my Internet connecti¢n
provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1 Log into the web-based configuration (192.168.0.1) and configure the WAN
side to use PPPOE.

Step 2 Enter your screen name followed by @aol.com for the user name. Enter
your AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything
higher than 1400.

Step 4 Apply settings.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different internet service provider and want
to use the AOL software, you can do that without configuring the router’s firewall
settings. You need to configure the AOL software to connect using TCP/IP.

Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web

browser and enter the IP \-"il.'tual Scr\:cr is used to allow Intemet users access to LAN services.
Address of your D-Link router G e

" Enabled © Disabled
(192.168.0.1). Enter username - oo R

(admin) and your password
(blank by default).

Prevate P |192.168.0.100

Protocol Type  |UDP =]

Private Port |22

Step 2 Click on Advanced

on top and then click Virtual PuicPer P2 <]

Server on the left side. ol —
 From Time [00 > [00 =] [aM =] 1o [00 =] . [00 =] [am ~]

Step 3 Check Enabled to Day Sun =] 1o |Sun =

activate entry.
Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone
that was set up between North Korea and South Korea following the UN police action
in the early 1950s.) A DMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access
to Web sites or other companies accessible on the public network. The DMZ host
then initiates sessions for these requests on the public network. However, the DMZ
host is not able to initiate a session back into the private network. It can only forward
packets that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served

to the outside world. However, the DMZ provides access to no other company data.
In the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

a DMz

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the
local network. The DMZ, or Demilitarized Zone, will allow the specified computer
to be exposed to the Internet. DMZ is useful when a certain application or game
does not work through the firewall. The computer that is configured for DMZ will be
completely vulnerable on the Internet, so it is suggested that you try opening ports
from the Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based configuration
of the router by typing in the IP Address

of the router (default:192.168.0.1) in your
web browser. The username is admin (all ’,ﬂj;"lﬁf
lowercase) and the password is blank '

(nothing).

()

ChfL-17004AP

LUset name:

Password:

:ﬁ admin V|

[]remember my password

[ Ok H Carice| ]

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable
and type in the IP Address you found in step 1.

Step 4 Click Apply
and then Continue to
save the changes.

Note: When DMZ is
enabled, Virtual Server
settings will still be
effective. Remember,
you cannot forward the
same port to multiple
IP Addresses, so the
Virtual Server settings
will take priority over

DMZ settings.

AirPlusG

802.11g/2.4GHz Wireless Router

[ Home B TCLSLBM Tools Status Help

DMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to

the Intemet.

 Enabled & Disabled

192.1&3.U.ﬁ

IP Address
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Frequently Asked Questions (continued)

How do | open a range of ports on my DI-524 using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.

Step 3 Click on D - =
Enabled and type ina [ e AirPlusG

name for the new rule. 802.119/2.4GHz Wireless Router

DI-5.

‘i‘ _ -_m ~ Advanced [P Status____Help
Step 4 Choose WAN — f llr:m;‘ail ;{ul’as can be used to allow or deny traffic from passing through the DHG24.
as the Source and Nirwotserver € Enabled O Disabled
enter a range of IP e —
Addresses out on the Fionicons L g
N Interface IF Hange Stat  IF Range End Protocol Fort Range
internet that you would pre— N | I
like this rule applied Destination [* <] [ |

H Sechedule « Abways

to. If you would like — e b e T R o 2
fchls rule to allow all | day [Sun =] to [Sum =]
internet users to be v 9 90
able to access these : Apply Cancol Help

T_ Action  Name Source  Destinalen Frotocol
ports! -then pUt an F Allow Allow to Ping WAN port \I\:\N_‘ IAN_].’D“ISB(] 1 IEMP A __-f
Asterisk in the first ' Deny Defaut LA PEr
box and leave the e T e
second box empty.

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming service.

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer

and then open port 81 to the other computer. 79



Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an
FTP Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and
a VPN server at 192.168.0.7, then you need to specify the following virtual server
mapping table:

Ceoron | s |

21 192.168.0.5 X
80 192.168.0.6 X
1723 192.168.0.7 X

How do | use PC Anywhere with my DI-524 router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.

Step 1 Open your web browser and enter the IP Address of the router
(192.168.0.1).

Step 2 Click on

Advanced at the top
and then click Virtual
Server on the left side.

Step 3 Enter the
information as seen
below. The Private IP
is the IP Address of the

computer on your local
Step 4 The Tirst entry

will read as shown

Step 5 Click Apply

and then click Continue.

Virtual Server
Wirtual Server is used to allow Internet users access to LAN services.

' Enabled " Disabled

MName |pcanywheret M
Private IP W

Pratocal Type ITP_'_!

Private Port !22_ ~ I_

Public Pot [z ~[

Schedule * Always

€ From Time |00 =] :[00 ~||am =] 1o[00 > |00 =|[am ~]
Day Sun > Tngun 'i

80



Frequently Asked Questions (continued)

How do | use PC Anywhere with my DI-524 router? (continued)

Step 6 Create virtual Servi
a second entry “irtual Server is used to allow Internet users access to LAN services.

as shown here: & Enabled © Disabled

Marme |pcanywher82 Clear
Private IP 192.168.0.100

Protocol Type |TCP =
Private Port BE31 ~

Step 7 Click Public Paort BRI M

Apply and then Schedule & Always
click Continue. C From Time [00 =] : [00 =] [AM =] 7o [00 =] - [00 =] [AM =]
Day |Sun L] To |Sun LJ

Step 8 Create o , ,
a third and final Yirtual Server is used to allow Intermet users access to LAN semices.

entry as shown
here: ¢ Enabled " Dizabled
ere:

Name |pcanw;here3 Clear
Private IP 192.168.0.100

Protocal Type |UDP ]
Private Port W ~ ’—
Public Pot  [s637  ~[
Schedule & Always
 From Time |00 =] |00 v |AM | 1o|00 v |00 =] [AM =
Day [Sun 7| To[Sun =]

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address. 81



Frequently Asked Questions (continued)

How can | use eDonkey behind my DI-524 router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.

Step 3 Create a
new firewall rule:

E“?k Enabled. AirPlusG

r;jer:l name 802.11g/2.4GHz Wireless Router
Next to SOUI"CG, Firwall Ruloss can bir used to allow or deny traffic from passing through th DHE24
select WAN € Enabled © Disabled

H Marnu Clear
under I_nterface' lopll:wml Action © Adlow © Deny
In the f| rst bOX, Intorface IP Range Start 1P Range End Protocol  Pon Rangn
enter an *. Leave sowce [ Al '
Dinstination |* - TCP = I

the second box Sl l(‘ Mj,,ls I e
empty. I Firewall © Fram time [00 =] - [00 =] [ =] 0 [00 =] : [00 =] [2m =]
Next to day | Sun "I‘D Sun *[ o
Destination, oz o gw c:‘-fw 39
Se'eCt LAN under r— Aclion  Name Source Du:illuu.hun. Frolocol
interface. Enter Perfarmance g .;I::‘:r .;J;:;J;n Fling WAN port WAN m:]uz.lw.u.l :;M@FJ‘LI 4
the IP Address F Allow  Default LANS® 2 1P @),
of the computer
you are running

eDonkey from.
Leave the second
box empty. Under Protocol, select *. In the port range boxes, enter 4661 in the first

box and then 4665 in the second box. Click Always or set a schedule.

Step 4 Click Apply and then Continue.
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Frequently Asked Questions (continued)

How do | set up my DI-524 router for SOCOM on my Playstation 2?7

To allow you to play SOCOM and hear audio, you must download the latest firmware
for the router (if needed), enable Game Mode, and open port 6869 to the IP Address
of your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router
(192.168.0.1). Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue.

D-Link

Building Metwarks for Peaple

AirPlusG

802.119/2.4GHz Wireless Router

il vome BV Tool Staws  Hep |

Wirtual Server 15 used to allow Intemet users access to LAN semices.
T Enghjed © Disabled
I'j“"“’ [192.168.0.100 ows)
'meate IP I—
Pratocol Type %
I Filters Private Port
Public Port Iﬁﬁag_

f Firewall Schedule ® Atways
T From time 00 *‘I- o vi AW ~||a|m *‘I -I[I] vI Al 'l

T daril:iun "Im Sun 'I
IT= ' v
Performance \‘ @ o
Virtunl S . st Apply Cancel Help
Name Private IP Protocol Schedule
T Virtual Server FTP 0000 TCP 211 always IF} ]
™ Virtual Server HTTP 0000 TCP 8080 always ]
T Virtual Server HTTPS 0,000 TCP 4431443 always Bl ]
I Virtual Server DNS 0000 UDP 53/53 always E} ]

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply and
then Continue. 83




Frequently Asked Questions (continued)

How can | use Gamespy behind my DI-524 router?

Step 1 Open your web browser and enter the IP Address of the router
(192.168.0.1). Enter admin for the username and your password (blank by default).

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.

Step 3 You will create 2 entries.
Step 4 Click Enabled and enter
Settings:

NAME - Gamespy1

PRIVATE IP - The IP
Address of your computer
that you are running
Gamespy from.

PROTOCOL TYPE - Both

PRIVATE PORT - 3783
PUBLIC PORT - 3783

Click Apply and then continue

Step 5 Enter 2nd entry:
Click Enabled

NAME - Gamespy?2

PRIVATE IP -

The |IP Address
your computer that you are
running Gamespy from.

PROTOCOL TYPE - Both
PRIVATE PORT - 6500
PUBLIC PORT - 6500
SCHEDULE - Always.

Click Apply and then continue.
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[ __Home [ Tools Status
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Wirual Server is used 1o allow Intemot users access 10 LAN senices.
® Enabled T Disabled
Mams
Prate® [
Protocal Type  [TEP =]
PritePon [
Publie P [
Schaduls ® Adways
© From tieme [00 =] : [00=] [A =] 10 00 =]
day [Sun = 1o [Sn =]

Cluae |

@ A

2 20
Apply Cancel Help
Schedule
aways LA
avays  [45)
whways 459
iyt 4

Hame
I Virtual Serves FTP
T Wiriusl Sarves HTTR
I Virusl Serves HTTPS
I Vinual Serves DNS

Private IP
oooo
oooo
oooo
0000

Protocol
TGP 2121
TCP fen
TCP 44343
UDP 5353

AirPlusG

802.119/2.4GHz Wireless Router

[ __Home [ Tools Status Help
Wit Sorr 16 whd 10 lkw Inbemet users Sccess 16 LAN senices.
® Ensbled © Disabled
Mams Clear
Pincal
Protocal Type [ =]
Privale Port
Public Por
Sehaduls ® Aays
© From tiene [00 =] : [00 =] [A4 =] 10 [00 =] - [00 =] [ =]
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tusl S Apply Cancel Help
Hame Private IP Protocal Scheduls
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I Vinus! Sarver MTTR 0000 TCP E80 sways [
I Wirdusl Serves HTTPS 000o TCP 44343 ahways 4
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Frequently Asked Questions (continued)

How do | configure my DI-524 router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the KaZaA
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (kazaa for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

YWirtnal Server is used to allow Intemet users access to LAM services.

* Enabled © Disabled

Mame |kazaa Clear
Private IP 192.168.0.100

Protocol Type | TCP v]

Private Port ~ [1214 ~ |

Public Pot ~— [1214  ~|
Schedule o Always
C From Time |00 =| |00 = |aM ~| Tof00 =] |00 v [aM ~|
Day|8un jTgJSun j

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my DI-524 router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

For the DI-604, DI-614+, DI-
524, DI-754, DI-764, or DI-774:

AirPlusG

Step 1 Open your web browser 802.119/2.4GHz Wireless Router

DI-524
and enter the IP Address of - L vome ML ool ___stalue_tco___
your router (192.168.0.1). Enter | | R
username (admin) and your — S —
password (leave blank). P e 31

Private Por [

Step 2 Click on Advanced and e T

then click Virtual Server. =
—— ,
Step 3 Create a new entry: &cfw!g
. Hame Private IP  Protocol Echedule
Click Enabled. Enter a name ¢ mmsmer 0000 Torawn e
(warcraft3). Private IP - Enter the paiome O e o B

IP Address of the computer you

want to host the game. Select

Both for Protocol Type Enter 6112 for both Private Port and Public Port Click Always
or set a schedule.

Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
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Frequently Asked Questions (continued)

How do | use NetMeeting with my DI-524 Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs
like Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or
other h.323 software packages.

The solution is to put the computer in DMZ.

Note: A few hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my DI-524 router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients.

Step 1 Open your web browser and enter the IP Address of your router

(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

How do | set up my DI-524 router to use iChat? -for Macintosh users-
(continued)
Step 3 Create a new
firewall rule: ; 3
_ AirPlusG
CE:“?k Enabled. 802.11g/2.4GHz Wireless Router
nter a name
(ichat?) or2e | TR Advanced IEZETRMMTISSTTIN
Clle A"OW _ A rumau R‘ulle.ls.canbeusedto allow ar deny trafiic from passing through the DRG24.
Next to Source 5 Etanled & Diasing
’ lame Ii cwﬂ'
select WAN e — e —
d H rf - |r‘;mztr|:r¢g:::m=m 1P Rangi End Pratocal  Port Range
under interface. S |
In the first box, e [ | FEr—
enter an *.  Aways
Leave the I Firewall © From ::‘"E lEnlkr_;lrnm foo =] [am=]
¥ j j
secotnd box e 9 OO0
emp y P 2 innll. :‘ame‘i Source Etination Aooly cu“z:‘n pelp
Next to Prem— " :JTW :IIowml"ingWhN port WAN EA::.mé.r.n.l r::r'.al E]
. . F Deny Dasfault bl LANT [
Destination, ¥ Alow  Defaul Uans e e
select LAN
under interface.
Enter the IP

Address of the computer you are running iChat from.

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.
Click Always or set a schedule.
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Building Hetworks for People
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Step 4 Click Apply 802.119/2.4GHz Wireless Router

i DI1-5249
and then Continue. ST Advanced

inrwall Rules
Firewall Rules can be used 10 allew of deny UaMic from passng thisgh the DHo24

Wirlua| Server & Enabled © Disabled
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4 enter ichat2 and —_— Souce  [war=]F |

i Destination [LAN_=] 1921680100 | [0oF =] e . [16a
Schedule & Abways
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open ports 16384-
16403 (UDP).

It

day | Sun "Im Sun ¥
-

DME a d o
rwarll Rules List Apply Cancel Help
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Frequently Asked Questions (continued)

How do | set up my DI-524 router to use iChat? -for Macintosh users-
(continued)

For File Sharing:
Step 1 Click on
Advanced and then
Virtual Server.

D-Link

Builifing Metworks for People

AirPlusG

802.11g/2.4GHz Wireless Router

Step 2 Check Enabled

o autivate ontry. DLE24 | ST acvanced [ETSTERETSRNTY
Vittual Server is used 16 allow Infernat usess access to LAN samces.

Step 3 Enter a name  Enableg * Disabind

for your virtual server e s - =)

entry (ichat3). Frotocal Type [TCP =]

. Private Por 51490
Step 4 Next to Private PuicPt 1o

IP, enter the IP Address - Susis @ Abays

" Froan tlmom ,@:\M-Im[ﬂ lﬂm-l
of the computer on — =
your local network that
v i
you want to allow the 2 00
Incoming service to. Apply Concel Help
Nams Prvvate 1P Frotocod Schedule
I Wilusl Seever FTP 0000 TCP 2121 abways [H9
Step 5 Select TCP for I Wirlual Servar HTTP oooon TCP B0E0 abways £ |

Protocol Type.
Step 6 Enter 5190 next to Private Port and Public Port.
Stsp 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall is
active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X fire-
wall, the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may
keep the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number
5190 should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X
are outlined in technical document 106461, “Mac OS X: File Sharing” in the AppleCare
Knowledge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click

the Firewall tab and select the service you have chosen in the “Allow” list. If you do not
do this, the firewall will also block the file sharing service. *
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. It is proposed and described in
RFC-1631 and is used for solving the IP Address depletion problem. Basically, each
NAT box has a table consisting of pairs of local IP Addresses and globally unique
addresses, by which the box can “translate” the local IP Addresses to global address
and vice versa. Simply put, it is a method of connecting multiple computers to the
Internet (or any other IP network) using one IP Address.

D-Link’s broadband routers (ie: DI-524) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html

91




Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our wek
site, or by phone.

Tech Support for customers within the United States:
D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:
D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
e Serial number of the unit

o Model number or product name

o Software type and version number
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Warranty and Registration
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

. D-Link or its authorized reseller or distributor and

. Products purchased and delivered within the fifty states of the United States, the District of Columbia,
U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described below will
be free from material defects in workmanship and materials from the date of original retail purchase of the
product, for the period set forth below applicable to the product type (“Warranty Period”), except as otherwise
stated herein.

3-Year Limited Warranty for the Product(s) is defined as follows:

PR R R e e ) e

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period at
no charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will be
rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be new or
have an identical make, model or part. D-Link may in its sole discretion replace the defective Hardware (or
any part thereof) with any reconditioned product that D-Link reasonably determines is substantially equivalent
(or superior) in all material respects to the defective Hardware. Repaired or replacement Hardware will be
warranted for the remainder of the original Warranty Period from the date of original retail purchase. If a
material defect is incapable of correction, or if D-Link determines in its sole discretion that it is not practical to
repair or replace the defective Hardware, the price paid by the original purchaser for the defective Hardware
will be refunded by D-Link upon return to D-Link of the defective Hardware. All Hardware (or part thereof)
that is replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link
upon replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”) will
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in the
applicable documentation, from the date of original retail purchase of the Software for a period of ninety (90)
days (“Warranty Period”), provided that the Software is properly installed on approved hardware and operated
as contemplated in its documentation. D-Link further warrants that, during the Warranty Period, the magnetic
media on which D-Link delivers the Software will be free of physical defects. D-Link’s sole obligation shall
be to replace the non-conforming Software (or defective media) with software that substantially conforms
to D-Link’s functional specifications for the Software or to refund at D-Link’s sole discretion. Except as
otherwise agreed by D-Link in writing, the replacement Software is provided only to the original licensee,
and is subject to the terms and conditions of the license granted by D-Link for the Software. Software will
be warranted for the remainder of the original Warranty Period from the date or original retail purchase. If
a material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it
is not practical to replace the non-conforming Software, the price paid by the original licensee for the non-
conforming Software will be refunded by D-Link; provided that the non-conforming Software (and all copies
thereof) is first returned to D-Link. The license granted respecting any Software for which a refund is given
automatically terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software of D-
Link’s products will not be applied to and does not cover any refurbished product and any product purchased
through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the liquidators
expressly disclaim their warranty obligation pertaining to the product and in that case, the product is being
sold “As-Is” without any warranty whatsoever including, without limitation, the Limited Warranty as described
herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its return

policy. In case the return policy period has expired and the product is within warranty, the customer shall
submit a claim to D-Link as outlined below:
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. The customer must submit with the product as part of the claim a written description of the Hardware
defect or Software nonconformance in sufficient detail to allow D-Link to confirm the same.

e  The original product owner must obtain a Return Material Authorization (“RMA”) number from
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of the
product (such as a copy of the dated purchase invoice for the product) before the warranty service
is provided.

e  After an RMA number is issued, the defective product must be packaged securely in the original
or other suitable shipping package to ensure that it will not be damaged in transit, and the RMA
number must be prominently marked on the outside of the package. Do not include any manuals
or accessories in the shipping package. D-Link will only replace the defective portion of the Product
and will not ship back any accessories.

e  The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD”) is allowed. Products sent COD will either be rejected by D-Link or become the property
of D-Link. Products shall be fully insured by the customer. D-Link will not be held responsible for
any packages that are lost in transit to D-Link. The repaired or replaced packages will be shipped
to the customer via UPS Ground or any common carrier selected by D-Link, with shipping charges
prepaid. Expedited shipping is available if shipping charges are prepaid by the customer and upon
request.

Return Merchandise Ship-To Address
USA 17595 Mt. Herrmann, Fountain Valley, CA 92708
Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed warranty
information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product that
is not packaged and shipped in accordance with the foregoing requirements, or that is determined by D-Link
not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced or
removed; Initial installation, installation and removal of the product for repair, and shipping costs; Operational
adjustments covered in the operating manual for the product, and normal maintenance; Damage that occurs
in shipment, due to act of God, failures due to power surge, and cosmetic damage; Any hardware, software,
firmware or other products or services provided by anyone other than D-Link; Products that have been
purchased from inventory clearance or liquidation sales or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product. Repair by anyone other
than D-Link or an Authorized D-Link Service Office will void this Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY
TERRITORY WHERE APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE
LIMITED TO NINETY (90) DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY
PROVIDED HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND PERFORMANCE OF
THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER
ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY
FORANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER,
WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO
WHICH D-LINK’'S PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATA CONTAINED
IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR WARRANTY
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES. THE SOLE REMEDY FORABREACH OF THE FOREGOING LIMITED WARRANTY
IS REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.
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LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE

PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES
AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES,
EXPRESS, IMPLIED OR STATUTORY.
Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some states
do not allow exclusion or limitation of incidental or consequential damages, or limitations on how long an
implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited warranty provides
specific legal rights and the product owner may also have other rights which vary from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product

may be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976. Contents are subject to change without prior notice.

Copyright® 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communication. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.

. Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

. Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.

FCC Caution:
The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications
to this equipment; such madifications could void the user’s authority to operate the equipment.

(1) The devices are restricted to indoor operations within the 5.15 to 5.25GHz range. (2) For this
device to operate in the 5.15 to 5.25GHz range, the devices must use integral antennas.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.
The antenna(s) used for this equipment must be installed to provide a separation distance of at least
eight inches (20 cm) from all persons.

s

This equipment must not be operated in conjunction with any other antenna.

[ Register your D-Link product online at http://support.dlink.com/register/ ]

(07/11/2003) 95



